PowerLite® 1815p
Multimedia Projector

User’s Guide
Important Safety Information

**WARNING:** Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically explained in this *User’s Guide*, do not attempt to service this product yourself. Refer all servicing to qualified service personnel.

**WARNING:** The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small children to avoid any risk of suffocation.

**Caution:** When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Trademarks

Epson, Quick Corner, and Instant Off are registered trademarks, and Epson Exceed Your Vision and EasyMP are trademarks of Seiko Epson Corporation.

PowerLite and PrivateLine are registered trademarks; SizeWise is a trademark; and Epson Store and Epson Extra Care are service marks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

The contents of this manual are subject to change without notice.
Contents

Welcome ........................................... 9
Using Your Documentation ...................... 10
  Getting More Information ....................... 10
Registration and Warranty ....................... 11
Unpacking the Projector .......................... 12
  Additional Components .......................... 12
  Optional Accessories ............................ 13

1 Displaying and Adjusting the Image .......... 15
Positioning the Projector ....................... 16
Turning On and Off the Projector ............... 17
  Using the Direct Power On Function .......... 19
  Shutting Down the Projector .................. 20
Displaying an Image ............................. 20
Troubleshooting Display Problems .............. 21
  You Can’t Project an Image ................... 21
  The Projector and Notebook Don’t Display the
  Same Image ..................................... 21
Adjusting the Image ............................... 23
  Adjusting the Height of the Image ............ 23
  Focusing and Zooming the Image .............. 24
  Adjusting the Image Shape .................... 24
  Selecting the Color Mode ...................... 27
  Resizing Video Images .......................... 28
Presenting with the Remote Control .............. 29
Using the Remote Control .......................... 30
Controlling the Picture and Sound ................. 30
Switching Between Picture Sources ................ 30
Turning Off the Picture and Sound ............... 31
Stopping Action ...................................... 32
Zooming Part of Your Image ........................ 32
Controlling the Volume ............................... 33
Highlighting Your Presentation ...................... 33
Using the Pointer Tool ............................... 33
Customizing the Pointer Tool ...................... 34
Operating Your Computer with the Remote Control .... 34
Operating Two or More Projectors with the Remote Control ........ 35
Setting the Projector ID ............................ 35
Setting the Remote Control ID ..................... 36

Connecting to Computers, Cameras, and Other Equipment .................. 37
Connecting to a Computer ........................... 38
Connecting to the Computer Port .................... 38
Connecting to the USB Port .......................... 39
Connecting the Cable for Remote Mouse Control .... 40
Connecting to Video Equipment ...................... 41
Connecting a Composite Video Source .............. 43
Connecting an S-Video Source ...................... 44
Connecting a Component Video Source ............. 45
Connecting an RGB Video Source ................... 46
Connecting an External Monitor .................... 47
Playing Sound Through the Projector ................ 48
Connecting External Speakers ..................... 49
Connecting to a Digital Camera or Other Device .......... 50
Removing the USB Cable ............................ 50
Inserting a CompactFlash Card ..................... 51
Inserting the Wireless 802.11g/b/a Module .......... 52
Connecting a Network Cable ....................... 53
4 Presenting Through a Wireless Network ........55
   Starting EasyMP ............................................. 56
   Configuring Basic Settings ............................... 57
   Configuring the Connection ............................... 58
       Using Ad Hoc Mode .................................. 59
       Using Access Point Mode ......................... 65
   Using Wireless Security Options ..................... 75
       Enabling WEP Encryption .......................... 75
       Enabling WPA Security ............................ 77
       Enabling EAP, LEAP, or PEAP Authentication .... 79
       Enabling EAP-TLS Certificate Validation .......... 80
   Projecting Over a Network ................................. 81
       Solving Connection Problems .................... 84
       Using the Control Bar .............................. 85
       Connecting in Advanced Connection Mode ....... 86
       Enabling Network Security ......................... 87
   Multi-screen Projection .................................. 90
   Projecting Video Clips .................................. 92
   Using Special Presentation Modes ................... 93
       Using Presentation Mode ........................... 94
       Using Presenter View ............................... 94

5 Presenting from a USB Drive, Camera, or CompactFlash Card ...........99
   Presenting Files From a USB Drive or CompactFlash Card .................... 100
   Presenting Image Files From a Digital Camera ........................... 101
   Creating a Slideshow on the Fly ................................ 102
       Displaying the Slideshow .......................... 102
       Controlling Your Slideshow ....................... 103
       Changing Timing and Other Settings ............... 104
   Creating a Scenario ....................................... 105
       Converting a PowerPoint File to a Scenario .... 106
       Creating a Scenario from Scratch ................ 107
   Transferring Your Scenario to a USB Drive or CompactFlash Card ......... 114
Presenting Scenarios ........................................ 116
  Controlling Your Scenario .............................. 117
Supported File Formats ................................. 118

6  Fine-Tuning the Projector ......................... 119
  Using the Menu System ............................... 120
    Restoring the Default Settings ................... 121
  Adjusting the Image .................................. 122
    Six-Axis Color Adjustment ....................... 123
  Adjusting Signal Settings ........................... 124
  Customizing Projector Features ................. 126
  Using the Projector Security Features ........ 127
    Enabling Password Protection .................. 127
    Creating Your Own Startup Screen ............ 129
    Disabling the Projector’s Buttons ............ 131
  Customizing Power and Operation .............. 132
    Multi-screen Color Adjustment ............... 134

7  Managing Projectors ................................. 135
  Connecting to a Wired Network ................. 136
  Using Projector E-mail Alerts ................ 137
  Using EMP Monitor .................................. 139
    Opening and Closing EMP Monitor ............ 139
    Registering a Projector ....................... 140
    Monitoring Your Projectors .................... 142
    Controlling Your Projectors ................... 146
    Configuring the Monitoring Interval ......... 147
  Using E-mail Alerts .............................. 147
    Understanding the Notification Messages .... 148
  Using a Browser to Monitor the Projector .... 149
  Transferring Files by FTP ....................... 151
8 Maintaining the Projector.......................... 153
    Cleaning the Lens .............................. 154
    Cleaning the Projector Case .................... 154
    Cleaning the Air Filter and Vent ................ 155
    Replacing the Lamp and Air Filter ............. 156
        Resetting the Lamp Timer ................... 159
        Checking Lamp Usage ...................... 159
    Replacing the Batteries ...................... 160
    Transporting the Projector .................... 161

9 Solving Problems ................................. 163
    Using On-Screen Help ......................... 164
    Checking Projector Status .................... 165
        What To Do When the Lights Flash .......... 165
    Solving Projector Operation Problems .......... 167
    Solving Problems with the Image or Sound .... 167
    Solving Network Problems ..................... 173
    Solving EasyMP Problems ..................... 175
    Solving Problems with the Remote Control ..... 177
    Where To Get Help ............................. 178
        Speak to a Support Representative ....... 178

A Software Installation ............................ 181
    Windows System Requirements .................. 181
    Mac System Requirements ...................... 182
    Installing the Software on a Windows System .. 182
    Installing the Software on a Mac. ............... 183
Welcome

The PowerLite® 1815p is an easy-to-use projector that weighs less than 7 pounds. The projector offers up to 3500 lumens of brightness. You can connect it to a wide range of computers and video sources, or you can project from a USB storage device, or over an 802.11g, 802.11b, or 802.11a wireless network.

Easy setup, control, and security:

■ 5-second startup time and Instant Off® feature for fast setup and shut down
■ Automatic digital keystone correction
■ 1.6x optical zoom lens for flexible placement and positioning
■ Security features include password, user’s logo, and the ability to lock the projector buttons
■ A/V mute slide (lens cover) to block the lens and save lamp life when you want to temporarily stop projecting

Additional enhancements:

■ Connect three computers, one via USB 2.0 cable and another two via VGA cable for multi-source presentations
■ Wirelessly send MPEG2 full screen video with audio from a PC
■ Project up to four different images from one computer
■ Color match images from up to four projectors for a uniform, wide-screen view
■ Project only the PowerPoint® slide images while viewing handout notes and controls on the computer screen
■ Perform six-axis color adjustment for fine art and photography
Using Your Documentation

This book contains all the information you need to set up and use your projector. Please follow these guidelines as you read through it:

- Warnings must be followed carefully to avoid bodily injury.
- Cautions must be observed to avoid damage to your equipment.
- Notes contain important information about your projector.
- Tips contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your projector? Here’s where you can look for help:

- Quick Setup sheet
  Gives you the instructions you need to get your projector up and running if you are connecting to a notebook, MacBook™, PowerBook®, or iBook® computer, or projecting over a wireless network.

- Projector kit
  Includes this User’s Guide, your Quick Setup sheet, warranty brochures, and Epson PrivateLine® Support card. Keep the kit with your projector at all times.

- Built-in help system
  Provides assistance for common problems. Available from the Help button on the projector or the remote control. See page 164 for details.

- epson.com/support
  Download FAQs and e-mail your questions to Epson support.

- If you still need help after checking this User’s Guide and the sources listed above, you can use the Epson PrivateLine Support service to get help fast. Call (800) 637-7661 and enter the PIN on the PrivateLine card. Or take advantage of Epson’s automated support services 24 hours a day. See page 178 for more information.
■ presentersonline.com
Includes a library of articles covering presentation tips, tricks, and technology. The site provides templates, clip art and sound clips, as well as Presenters Services to use on the road. Even more resources and services are available if you register to join the Presenters Club—and it’s free.

Registration and Warranty

Your projector comes with a basic carry-in 2-year and 90-day lamp warranty as well as an international warranty that let you project with confidence anywhere in the world. For details, see the warranty brochures included with your projector.

In addition, for customers who register their projector, Epson offers free Extra CareSM Road Service. In the unlikely event of an equipment failure, you won’t have to wait for your unit to be repaired. Instead, Epson will ship you a replacement unit anywhere in the United States or Canada, usually via overnight delivery. See the brochure included with your projector for details.

To register, simply fill out the registration card and mail it to Epson. Or you can register online at epson.com/webreg. Registering also lets you receive special updates on new accessories, products, and service.
Unpacking the Projector

After unpacking the projector, make sure you have all these parts:

- Projector
- PDF manual and registration CD-ROM
- EasyMP™ software CD-ROM
- Wireless module and security screw
- Remote control and 2 AAA batteries
- USB cable
- Power cable
- VGA computer cable
- Carrying case

Save all packaging in case you need to ship the projector. Always use the original packaging (or the equivalent) when you need to send the projector to another location. If you are moving the projector by hand, use the carrying case. See page 13 for ordering information, and page 161 for transportation instructions.

Additional Components

Depending on how you plan to use the projector, you may need additional components:

- To receive an S-video signal, you’ll need an S-video cable.
- To receive a component video signal from a VCR or other video device, you’ll need an HD15 to component video cable.

You can purchase these items from Epson. See “Optional Accessories” on page 13.
Optional Accessories

To enhance your use of the projector, Epson provides the following optional accessories:

<table>
<thead>
<tr>
<th>Product</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement lamp</td>
<td>V13H010L40</td>
</tr>
<tr>
<td>Air filter replacement set (2 filters)</td>
<td>V13H134A08</td>
</tr>
<tr>
<td>Universal ceiling mount</td>
<td>ELPMBUNI</td>
</tr>
<tr>
<td>False ceiling plate</td>
<td>ELPMBFCP</td>
</tr>
<tr>
<td>Security bracket/cabling for gyro lock mounts</td>
<td>ELPMBSEC</td>
</tr>
<tr>
<td>Adjustable ceiling channel</td>
<td>ELPMBACC</td>
</tr>
<tr>
<td>Suspension adapter</td>
<td>ELPMBAPL</td>
</tr>
<tr>
<td>Kensington® security lock</td>
<td>ELPSSL01</td>
</tr>
<tr>
<td>50-inch portable screen (4:3 aspect ratio)</td>
<td>ELPSC06</td>
</tr>
<tr>
<td>60-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC07</td>
</tr>
<tr>
<td>80-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC08</td>
</tr>
<tr>
<td>83.6-inch hanging pull-down screen (4:3 aspect ratio)</td>
<td>ELPSC09</td>
</tr>
<tr>
<td>DUET Portable Projector Screen (4:3/16:9 combination)</td>
<td>ELPSC80</td>
</tr>
<tr>
<td>HD-15 to component video cable</td>
<td>ELPKC19</td>
</tr>
<tr>
<td>S-video cable</td>
<td>ELPSV01</td>
</tr>
<tr>
<td>Distribution amplifier</td>
<td>ELPDA01</td>
</tr>
<tr>
<td>Image presentation camera (ELPDC05)</td>
<td>V12H162020</td>
</tr>
</tbody>
</table>

You can purchase screens or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
1

Displaying and Adjusting the Image

Whether you’re presenting from a computer or video equipment, you need to follow some basic steps to display your image on the screen.

Follow the guidelines in this chapter for:

■ Positioning the projector
■ Turning on and off the projector
■ Displaying an image
■ Troubleshooting display problems
■ Adjusting the image
Positioning the Projector

If the projector isn’t already installed in the room you’re using, you’ll probably want to place it on a table in front of the screen, as shown. This lets you stand in the front of the room, face the audience, and remain close enough to the equipment to be able to control it. Try to leave as much space as possible between the projector and the screen to get a good-size image.

Use the figure below to help you determine placement. Image size increases with distance, but can vary depending on how you position the zoom ring and whether you’ve adjusted the image with other settings.

Also keep these considerations in mind:

- Place the projector on a sturdy, level surface.
- Make sure there is plenty of space for ventilation around and under the projector. Do not set the projector on top of anything that could block the vents under the projector.
- Make sure the projector is within 10 feet of a grounded electrical outlet or extension cord.
Ideally, you should place the projector directly in front of the center of the screen, facing it toward the screen squarely. The base of the lens should be at about the level of the bottom of the screen.

If you place the projector below screen level, you'll have to tilt it up by extending the front adjustable foot. This causes the image to become “keystone” shaped, but you can correct the distortion (see page 24).

For instructions on installing the projector in a permanent location, such as a theater or conference room, see page 185.

**Turning On and Off the Projector**

Turn on any connected computer or video equipment before starting the projector so it can automatically detect and display the image source. If you turn on the projector first, or have multiple pieces of connected equipment, you may have to select the image source manually (see page 20).
Follow these steps to turn on the projector:

1. Open the A/V mute slide (lens cover).

2. Plug one end of the power cable into the projector, and the other end into an electrical outlet.

**note**
You can set the projector to automatically turn off the projector lamp and enter “sleep mode” when it has not received any signals for 30 minutes. This conserves electricity, cools the projector, and extends the life of the lamp. If you want to start projecting again, press the Power button. If you are done using the projector, unplug the power cord. To enable sleep mode, see page 132.

The Power light turns orange.
3. Press the \textit{Power} button on the remote control or on top of the projector.

The projector beeps once and the Power light flashes green as the projector warms up, then an image begins to appear. When the Power light stops flashing and remains green, the projector is ready for use.

4. If you are prompted to enter a password, see page 129.

\textit{Using the Direct Power On Function}

The Direct Power On function enables faster setup. The projector starts up automatically when you plug it in or turn it on with a wall switch. You don’t have to press the \textit{Power} button.

Follow these steps to enable Direct Power On:

1. Press the \textit{Menu} button on the remote control or projector and select the \textit{Extended} menu.
2. Choose \textit{Operation} and press \textit{Enter}.
3. Choose \textit{Direct Power On} and press \textit{Enter}.
4. Highlight \textit{On} and press \textit{Enter}.
5. Press \textit{Menu} to exit. The setting will take effect the next time you plug in the projector.

\textbf{warning}\n
Never look into the lens when the lamp is on. This can damage your eyes, and is especially dangerous for children.

\textbf{note}\n
If a power outage occurs when Direct Power On is enabled and the projector is plugged in, the projector will start when the power is restored.
Shutting Down the Projector

This projector incorporates Instant Off technology. To turn it off, you can press its Power button as described below, unplug it, or turn off a power switch that supplies power to the projector. You don’t have to wait for the projector to cool off first.

1. To turn off the projector, press the Power button on the remote control or projector.

   You see a confirmation message.
   (If you don’t want to turn it off, press any other button.)

2. Press the Power button again. The projection lamp turns off and you can unplug the power cord.

   If you want to turn the projector on again, make sure the orange Power light is not flashing, then press the Power button.

Displaying an Image

You may need to select the image source if you have multiple video sources connected to the projector (such as a computer or DVD player). Selecting the image source lets you switch between images input from different pieces of connected equipment.

If you don’t see the image you want, press the Search button on the remote control or the Source Search button on the projector until you see the image you want to project.

You can also use the Source buttons on the remote control to switch between devices connected to the ports identified on each button, or select EasyMP to project wirelessly or from a USB drive.

note
Lamp life results will vary depending on mode selected, environmental conditions, and usage.

Turn off this product when not in use to prolong the life of the projector.
Troubleshooting Display Problems

Follow these guidelines if you’re having trouble displaying an image.

You Can’t Project an Image

If you don’t see the image you are trying to project, try the following:

- Make sure the cables are connected correctly, as described beginning on page 37.

- Make sure the Power light is green and not flashing and the A/V mute slide (lens cover) is open.

- If you’ve connected more than one computer and/or video source, you may need to press the Source Search button on the projector’s control panel or Search button on the remote control to select the correct source. (Allow a few seconds for the projector to sync up after pressing the button.)

- If you’re using a PC notebook, press the function key on your keyboard that lets you display on an external monitor. It may be labeled CRT/LCD or have an icon such as \( \text{CRT/LCD} \). You may have to hold down the \( \text{Fn} \) key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.

The Projector and Notebook Don’t Display the Same Image

If you’re projecting from a notebook, and you can’t see your image on the projection screen and on your computer at the same time, follow these guidelines.

If you’re using a PC notebook:

- On most systems, there’s a function key that lets you toggle between the LCD screen and the projector, or display on both at the same time. It may be labeled CRT/LCD or have an icon such as \( \text{CRT/LCD} \). You may have to hold down the \( \text{Fn} \) key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.
If the function key doesn’t permit you to display simultaneously on both screens, you should check your monitor settings to make sure both the LCD screen and the external monitor port are enabled.

From the Control Panel, open the Display utility. In the Display Properties dialog box, click the Settings tab, then click Advanced. The method for adjusting the settings varies by brand; you may need to click a Monitor tab, then make sure the external Monitor port is set as your primary display and/or enabled. See your computer’s documentation or online help for details.

*If you’re using Mac OS X:*
You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple® menu, select System Preferences, then select Displays.
2. Make sure the VGA Display or Color LCD dialog box is selected.
3. Click the Arrangement (or Arrange) tab.
4. Make sure the Mirror Displays checkbox is selected.
Adjusting the Image

Once you see your image, you need to make certain adjustments:

■ If the image is too high or too low, reposition it as described below.

■ To focus or zoom your image, see page 24.

■ If the image isn’t square, see page 24.

■ To quickly adjust the color, brightness, or contrast, see page 27.

■ To change the image aspect ratio, see page 28.

■ If you need to fine-tune the image and/or sound, see Chapter 6.

Adjusting the Height of the Image

If the image is too low on the screen, you can use the front adjustable foot to raise it.

1. Stand behind the projector. Press the foot release lever up and lift the front of the projector.

2. Once the image is positioned where you want it, release the lever to lock the foot in position.

3. If necessary, you can fine-tune the height or level the image by turning any of the projector’s adjustable feet.

Raising the projector causes the image to distort or “keystone,” but you can correct the shape as described on page 24.
Focusing and Zooming the Image

Turn the focus ring on the projector to sharpen the image.

Turn the zoom ring on the projector to reduce or enlarge the image.

If the image still isn’t large enough, you may need to move the projector farther away from the screen. You can also use the E-Zoom buttons on the remote control to zoom in on a portion of the image. See page 32 for instructions.

Adjusting the Image Shape

You can maintain a square or rectangular image by placing the projector directly in front of the screen and keeping it level. This also produces the best picture quality. If the projector is tilted up or placed at an angle, you’ll need to correct the image shape by using one of the functions described below.

Automatic Image Adjustment

Use the projector’s Quick Setup feature to set up quickly for a presentation. This function automatically corrects the shape and position of the image to fit on a screen with a 4:3 aspect ratio. It can correct image distortion when the projector is placed up to a 45° angle to the screen (vertically) and 20° (horizontally).

1. Press the Quick Setup button on the projector’s control panel.
You see a projected message:

2. Aim the projector so the message appears near the middle of the screen. Then use the zoom ring to enlarge the image so the white frame (not shown above) extends beyond the edges of the screen on all sides.

3. Press the Quick Setup button again. Two white boxes flash momentarily onto the screen, and the adjustment is complete. Your projected image now fits on the screen (some slight overlap is normal).

The Quick Setup adjustment is retained when the projector is turned off. If the projector is installed in a fixed location, you won’t need to repeat the adjustment each time you turn it on. To fine-tune the Quick Setup adjustment, use Quick Corner® (below).

**Using Quick Corner**

Use Quick Corner to adjust the shape and size of the image when it’s uneven on all sides, or to finely adjust the image after performing Quick Setup. If you just used Quick Setup, you can use the projector’s arrow buttons to make the Quick Corner adjustment. If not, you’ll have to select Quick Corner as follows:

1. Press the **Menu** button on the remote control or on the projector’s control panel.
2. Select the **Settings** menu and press **Enter**.
3. From the Settings menu, select **Keystone** and press **Enter**.
4. Select **Quick Corner** and press **Enter**.

---

**note**

If Quick Setup did not detect the edges of your screen (for example, if you’re projecting on a wall), then the arrow buttons will be in Keystone correction mode after performing Quick Setup (see page 26).
You see this screen:

5. Use the  pointer button on the remote control (or the arrow buttons on the projector) to select the corner you want to adjust, and press Enter.

6. Use the  pointer button on the remote control (or the arrow buttons on the projector) to adjust the shape.

7. Repeat steps 5 and 6 as needed to adjust any remaining corners.

8. When done, press Menu to exit the menu system.

**Using Keystone Correction**

The projector automatically corrects vertical keystone distortion when it is tilted within a range of 30° up or down.

It takes about one second after projection starts for the image to be corrected. During this time, a vertical keystone correction gauge appears on the screen. If keystone correction isn’t automatically carried out, you may need to turn on the Auto V-Keystone setting in the projector’s menu system (see page 126).
You can manually adjust the shape of the image to compensate for vertical and horizontal keystone distortion. First make sure the Keystone setting in the projector’s menu system is set to H-Keystone or V-Keystone:

1. Press the Menu button on the remote control (or on the projector’s control panel).
2. Select the Settings menu and press Enter.
3. From the Settings menu, select Keystone and press Enter.
5. Select H-Keystone (for horizontal adjustment) or V-Keystone (for vertical adjustment) and use the ▼ and ▶ arrow buttons to adjust the shape of the image.

If the image becomes smaller, use the zoom ring to enlarge the image so it fits the screen. If the image contains faint lines or a gridlike pattern, decrease the sharpness setting (see page 123).

### Selecting the Color Mode

The Color Mode adjusts the brightness, contrast, and color for various common viewing environments. Use this setting to quickly obtain a good picture.
Press the Color Mode button on the remote control, and then select from one of these options:

- **Presentation**: For making color presentations in a bright room.
- **Text**: For making black-and-white presentations in a bright room.
- **Theatre**: For watching movies in a darkened room; gives images a natural tone.
- **Photo**: For vivid, high-contrast still images in a bright room.
- **Sports**: For vivid TV images projected in a bright room (video, S-video, or composite video only).
- **Game**: Increases brightness when playing video games or watching TV in a bright room. Emphasizes dark gradations.
- **sRGB**: Matches the color palette of standard sRGB computer displays.
- **Blackboard**: Projects accurate colors on a green chalkboard (adjusts the white point).
- **Customized**: For manual color adjustment (see page 123).

**Resizing Video Images**

You can use the Resize button on the remote control to adjust how an image fits into the display area.

Press **Resize** to switch the aspect ratio between 4:3 and 16:9. This lets you play certain digital video images or movies recorded on certain DVDs in 16:9 widescreen format. You can also select **16:9 (Up)** or **16:9 (Down)** to reposition videos to accommodate subtitles or supertitles.

For computer images, select **Normal** to automatically resize the image and make the best use of the display area.
Presenting with the Remote Control

The projector includes a number of tools to enhance your presentation. All of them can be accessed using the remote control, which lets you operate the projector from anywhere in the room—up to 20 feet away.

You can use the remote control to adjust the picture and sound (page 30) or as a pointer to highlight your presentation (page 33). You can also use it as a wireless mouse when projecting from a computer (page 34), or to control two or more projectors at the same time (page 35).

This chapter covers:

■ Using the remote control
■ Controlling the picture and sound
■ Highlighting your presentation
■ Operating your computer with the remote control
■ Operating two or more projectors with the remote control
Using the Remote Control

Make sure batteries are installed as described on page 160. Follow these tips for using the remote control:

- Point the remote control at the front of the projector or at the screen.
- Stand within 20 feet of the projector.
- Avoid using the remote under bright fluorescent lamps or in direct sunlight, or the projector may not respond properly.

Controlling the Picture and Sound

You can use the remote control to preview and select your picture sources, temporarily turn off the picture and sound, freeze the action, zoom in on the picture, and adjust the volume.

Switching Between Picture Sources

If your projector is connected to more than one computer and/or video source, you can switch between the different sources:

- The easiest way to select your source is to press the Search button on the remote control (or the Source Search button on the projector) repeatedly until you see the image you want on the screen.
- On the remote control, there are several Source buttons. Use them to switch between equipment connected to the port identified on each button, or to use EasyMP (PowerLite 1815p only).
After you select a source, the screen goes dark for a moment before the image appears.

**Turning Off the Picture and Sound**

You can temporarily turn off the image and sound when you want to redirect your audience’s attention. There are two ways to do this:

- Close the A/V mute slide, as shown below:

- Press the A/V Mute button on the remote control. This turns the image black and stops the sound. To turn the image and sound back on, press the button again.

You can have the screen turn blue when you press the A/V Mute button. You can also have an image, such as a company logo, display on the screen (see page 129).
**Stopping Action**

You can use the remote control to stop the action in your video or computer image.

- To stop the action and keep the current image on the screen, press the **Freeze** button. The sound continues.
- To restart it, press the **Freeze** button again.

**note**

This function pauses the image, not the sound. Because the source continues to transmit signals, when you resume the action, it won’t be at the point you stopped it.

**Zooming Part of Your Image**

You can zoom in on a portion of the image using the **E-Zoom** buttons on the remote control.

1. Press the **E-Zoom** button on the remote control.
   
   You see a crosshair indicating the center of the zoom-in area.

2. Use the pointer button to position the crosshair.

3. Continue pressing the **E-Zoom** button to enlarge the selected area up to 4 times.

4. While the image is enlarged, you can:
   
   - Use the pointer button to move around the screen.
   - Press the **E-Zoom** button to zoom out.

5. When done, press the **ESC** button to return the image to its original size.
### Controlling the Volume

To change the volume, press the \( \mathbf{+} \) or \( \mathbf{-} \) button on the remote control.

You can also adjust the volume using the projector’s menu system. See page 126.

### Highlighting Your Presentation

You can display a pointer to call out important information on the screen. If you want to customize the pointer tool, you can choose from three alternative shapes.

### Using the Pointer Tool

1. To activate the pointer tool, press the \textit{Pointer} button on the remote control. A pointer appears on the screen.

2. Use the \( \mathbf{\textcircled{4}} \) pointer button on the remote control to position the pointer on the screen.

\begin{center}
\textit{note}
To temporarily shut off the sound and picture, press the A/V Mute button or close the A/V mute slide.
\end{center}
3. When you’re done using the pointer, press Esc to clear the screen.

**Customizing the Pointer Tool**

You can change the appearance of the pointer by choosing from three alternative shapes.

1. Press the Menu button on the remote control, highlight the Settings menu, highlight Pointer Shape, and press Enter. You can select one of the pointer shapes shown at the left.
2. Select the shape you want and press Enter.
3. Highlight Return and press Enter.
4. Press Menu to exit from the menu system.

**Operating Your Computer with the Remote Control**

If you connect a computer to the projector with a USB cable, as described on page 40, then select Wireless Mouse for the USB Type B setting in the Extended menu (see page 133), you can use the remote control in place of your computer’s mouse. This gives you more flexibility when delivering slideshow-style presentations, since you won’t have to stand next to the computer to change slides.

- Use the Up and Down buttons to move through a Microsoft® PowerPoint slideshow.
Presenting with the Remote Control

- Use the \( \bigcirc \) pointer button to move the pointer on the screen.
- Press the \textbf{Enter} button once to left-click, or press it twice to double-click. Press the \textbf{Esc} button to right-click.
- To drag-and-drop, hold down the \textbf{Enter} button. Then use the \( \bigcirc \) pointer button to drag the object. When it’s where you want it, release the \textbf{Enter} button.

**Operating Two or More Projectors with the Remote Control**

If you’re using more than one projector, you can control all the projectors—or just selected ones—by using the projector ID system. To operate a projector, you have to set the remote control’s ID to match that of the projector. Or you can control all the projectors at once by setting the remote control’s ID to zero.

**Setting the Projector ID**

The projector’s default ID is set to Off. This lets it respond to commands from any remote control. To change the ID, follow these steps:

1. Press the \textbf{Menu} button on the remote control. You see the projector’s menu screen.
2. Select Extended > Projector ID.
3. Use the \( \bigcirc \) pointer button to highlight the new ID, and press \textbf{Enter} to select it.
4. When done, press Menu to exit the menu system.

**Setting the Remote Control ID**

The remote control’s default ID is zero. This lets you operate any projector. To set it to operate a specific projector, follow these steps:

1. Point the remote control at the projector you want to be able to operate.

2. Press and hold the ID button on the remote control.

3. While holding the ID button, press a numbered button on the remote control (0 through 9) to select the desired ID. Select zero to control all projectors, or select a number to match the ID of the projector(s) you want to operate.

After setting the ID, you can check whether the remote control works with a specific projector:

1. Point the remote control at the projector you want to check.

2. Press the ID button on the remote control. You see a message on the screen like one of these:

   ![Remote Control Menu Screen](image)

   **Projector ID : 3**  
   **Remote Control: On**  
   **Projector ID : 3**  
   **Remote Control: Off**

If the message says the remote control is “On,” then you can use the remote control to operate that projector. If it says “Off,” then you have to change the ID of the remote control and/or projector before operation is possible.

---

*note*  
If you’re using a remote control ID other than the default ID of zero, you have to set the ID each time you turn on the projector.
Connecting to Computers, Cameras, and Other Equipment

This chapter tells you how to connect the projector to a notebook or desktop computer, and/or to video equipment, such as a VCR, DVD player, or video camera. You can also connect the projector to a USB storage device or digital camera, use it with a CompactFlash® memory card, or connect it to your local area network.

Follow the instructions in this chapter on:

- Connecting to a computer
- Connecting video equipment
- Connecting an external monitor
- Playing sound through the projector
- Connecting to a digital camera or other USB device
- Inserting a CompactFlash card
- Inserting the wireless 802.11g/b/a module
- Connecting a network cable
Connecting to a Computer

You can connect the projector to any computer that has a standard video output (monitor) port, including desktop models, PC notebook computers, MacBook, PowerBook, and iBook computers, and hand-held devices.

You can also connect a Windows computer to the Type B USB port on the projector (see page 39). This allows you to connect an additional computer to the projector. If you want to use the projector’s remote control as a wireless mouse to operate your computer during presentations, see page 40.

Connecting to the Computer Port

You can connect to the projector using the VGA computer cable that came with it (the monitor port on your computer must be a mini D-sub 15-pin port).

1. If you’re using the VGA computer cable, connect one end to the projector’s Computer1 or Computer 2 port, and the other end to your computer’s monitor port.

   caution
   Don’t try to force a connector to fit a port with a different shape or number of pins. You may damage the port or connector.

2. You may need to change the Computer1 Input or Computer2 Input setting in the projector’s Signal menu to RGB (see page 125).
3. You can connect an optional stereo mini-jack audio cable to play sound through the projector (see page 48), or connect a USB cable to use the remote control as a mouse (see page 40).

4. When you’ve finished making any connections, see page 17 for instructions on turning on the projector and adjusting the image.

**Connecting to the USB Port**

You can connect a Windows XP or Windows 2000 (SP4) computer to the projector’s Type B (square) USB port and project your computer’s display. A USB 2.0 connection provides better picture quality and response than USB 1.1.

The first time you connect a computer to the projector’s USB port, software from the projector installs on your computer.

1. Follow the instructions beginning on page 17 to turn on the projector and adjust the image.

2. Make sure the USB Type B setting under the projector’s Extended menu is set to **USB Display** (see page 133).

3. Turn on your computer.

4. Locate the USB cable that came with your projector.

5. Connect the square end of the cable to the projector’s Type B (square) USB port.

---

**note**

You can’t use the remote mouse control function when you use the USB port to project your computer’s display.
6. Connect the flat end of the cable to any available USB port on your notebook or desktop computer. Messages appear as the projector is recognized and the software installation begins.

7. Follow the instructions on your computer screen to install the Epson USB Display software. If you see a “Digital Signature Warning,” select Continue. You will only need to install the software the first time you connect.

After the software has installed, you see your computer’s desktop displayed by the projector. You can switch the projector to other image sources using the Source buttons on the remote control, and then switch back to your desktop display by pressing EasyMP.

When you’re done projecting from your computer, disconnect the USB cable.

---

**Connecting the Cable for Remote Mouse Control**

If you’ve connected a computer as described in this chapter (using the Computer 1 or Computer 2 port) and set the USB Type B setting under the projector’s Extended menu to Wireless Mouse (see page 133), you can use the projector’s remote control as a wireless mouse. This lets you control your computer and click through slideshow-style presentations, such as PowerPoint, from up to 20 feet away.
The wireless mouse function is supported on systems with a USB port running Windows Vista™, Windows XP, 98SE, Me, or 2000, or Mac OS X 10.2.x to 10.4.x.

1. Connect the square end of a USB cable to the projector’s USB port.

2. Connect the flat end of the cable to any available USB port on your notebook or desktop computer.

3. If necessary, configure your computer to work with an external USB mouse. See your computer documentation for details.

Connecting to Video Equipment

You can connect several video sources to the projector at the same time. Before starting, look at your video equipment to determine its available video output connections:

- If your video player has a yellow RCA-style video output connector, see “Connecting a Composite Video Source” on page 43.
- If your video player has an S-video connector, see “Connecting an S-Video Source” on page 44.
If your video player has a component video port (three connectors labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a Component Video Source” on page 45.

If your video player has an RGB video port (either a single connector for a VGA-style monitor cable or three connectors labeled R/G/B), see “Connecting an RGB Video Source” on page 46.

After connecting video cables, you may also want to connect an audio cable to play sound through the projector; see page 48.
Connecting a Composite Video Source

1. Locate an RCA-style video cable (one is usually provided with your video equipment or you can purchase one from an electronics dealer).

2. Connect the cable to the yellow video output connector on your player and the yellow Video connector on the projector:

3. If you want to play sound through the projector, see page 48 for instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 17 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.
Connecting an S-Video Source

1. Locate an S-video cable (one is usually provided with your video equipment or you can purchase one from Epson; see page 12).

2. Connect the cable to the S-video connector on your player and the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 48 for instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 17 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.
Connecting a Component Video Source

You will need a special cable to connect your component video equipment to the HD15 (VGA-style) connector on the projector. You can order the HD15 to component cable (ELPKC19) from Epson; see page 13 for more information.

1. Locate an HD15 to component video cable or adapter.
2. Connect the cable to your player and the Computer 1 or Computer 2 connector on the projector.

3. You may need to change the Computer1 Input or Computer2 Input setting in the projector’s Signal menu to Component (see page 125).

4. If you want to play sound through the projector, see page 48 for instructions on connecting audio cables.

5. If you don’t need to make any other connections, see page 17 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.

**note**

Be sure your video player is not an RGB video source. If you select the wrong source, image quality may suffer. Check your video player’s documentation.

Also, make sure the Computer Input setting in the Signal menu is set to Auto or Component Video (see page 125).
Connecting an RGB Video Source

1. Locate the VGA computer cable provided with the projector.

2. Connect the cable to the video port on your player and the Computer1 or Computer2 port on the projector.

3. You may need to change the Computer1 Input or Computer2 Input setting in the projector’s Signal menu to RGB (see page 125).

4. If you want to play sound through the projector, see page 48 for instructions on connecting audio cables.

5. If you don’t need to make any other connections, see page 17 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.

note
Be sure your video player is not a component video source. If you select the wrong source, image quality may suffer. Check your video player’s documentation.
**Connecting an External Monitor**

If you want to monitor your computer presentation close-up (on a monitor placed beside the projector) as well as on the screen, you can connect an external monitor. You can use it to check on your presentation even if you’ve pressed the A/V Mute button or switched to a different picture source.

First make sure your computer’s VGA cable is connected to the projector’s Computer1 port (see page 38). Then connect your monitor to the projector’s Monitor Out port, as shown:

---

**note**

The monitor cannot display component video, nor computer images via the Computer2 or USB port.

Some LCD monitors may not be able to display the image correctly. If you have trouble displaying the image, connect a multiscan monitor. If you’re projecting computer images, make sure the computer’s refresh rate is set to 65 Hz or greater.
Playing Sound Through the Projector

You can play sound through the projector’s speaker system or attach an external speaker system.

To play sound through the projector, follow these steps:

1. Locate the appropriate cable and connect it to the Audio jack on the projector.
   - If you have equipment connected to the Computer 1 or Computer 2 port, use a stereo mini-jack cable. Connect the cable to the Audio1 port (for Computer 1) or the Audio2 port (for Computer 2).
   - If you have equipment connected to the Video or S-Video port, connect an RCA-style audio cable to L-Audio-R.

2. Connect the other end of the cable to the audio output connector(s) on your computer or video equipment.
**Connecting External Speakers**

You can output sound to external speakers with built-in amplifiers. When you play sound through external speakers, the projector’s built-in speaker system is disabled.

1. Locate the appropriate cable to connect your speakers.
   
   Depending on your speakers, you may be able to use a commercially available audio cable with a stereo mini-jack connector on one end and pin jacks on the other end. For some speakers, you may have to purchase a special cable or use an adapter.

2. Connect the stereo mini-jack end of the audio cable to the **Audio Out** port on the projector.

3. Connect the other end of the cable to your speakers.

The projector’s internal speaker system is disabled while sound is output to external speakers. You can use the remote control to adjust the volume.
Connecting to a Digital Camera or Other Device

You can connect your digital camera, USB flash memory drive, USB hard drive, or multimedia storage viewer, such as the Epson P-5000 or Apple iPod®. Use the USB cable specified for your device. Then you can use your device's slideshow function or the projector's EasyMP PC Free feature (see page 99) to present images.

1. Connect the flat end of the USB cable to the flat USB port on the projector, as shown.

2. Connect the other end of the cable to your camera or other device.

Removing the USB Cable

If you’re using PC Free mode to project your images, exit PC Free mode before you remove the USB cable from the projector.

1. Position the cursor over the Exit button in the upper right corner of the PC Free screen.

2. Press the Enter button on the remote control to close PC Free mode.

3. Disconnect the USB cable.
Inserting a CompactFlash Card

You can use a CompactFlash card to store images, movies, and Scenario files. This lets you project your files without connecting to a laptop or PC.

To place your files on the card, copy them from your computer to the card using a card reader. If the projector is connected to your local area network, you can also send the files to the card over the network (see page 151).

Insert the CompactFlash card face-up into the slot as shown:

The indicator light next to the slot comes on or flashes when the CompactFlash card is in use. Do not remove the card when the light is on or flashing.

To remove the card, press the eject button next to the card slot. The button pops out. Press the button again to eject the card.

**note**
The memory card slot also accepts Microdrive™ cards. You can also use an SD™ card, Memory Stick®, or xD-Picture Card™ by inserting it in a CompactFlash adapter.

**caution**
Do not remove the card when the indicator light is on or flashing, or you may damage the card or projector.
Inserting the Wireless 802.11g/b/a Module

To use the projector over a wireless network, you need to install the projector’s wireless LAN module (included). Once the module is installed, see page 55 to configure the projector and your network.

1. Insert the wireless LAN module that came with your projector.

2. Turn the projector over and insert the included screw to secure the module and keep it from being easily removed.

caution
Use only the Epson 802.11g/b/a wireless module in the projector.

caution
Never remove the module while its indicator light is green or when projecting wirelessly. You may damage the module or lose data.
Connecting a Network Cable

To connect the projector to your local area network (LAN), use a commercially available 100baseTX or 10baseT network cable. To ensure proper data transmission, use a Category 5 shielded cable or better.

Connect the cable to the projector and your network port as shown:
Presenting Through a Wireless Network

This chapter tells you how to send pictures to the projector through a wireless network. Using EMP NS Connection, you can project images shown on your computer screen—including text, graphics, and video—directly to your audience.

You’ll find instructions in this chapter on:

- Starting EasyMP
- Configuring basic settings
- Connecting to the projector in Ad Hoc (computer-to-computer) mode or Access Point (infrastructure) mode
- Using wireless security options
- Projecting wirelessly
- Multi-screen projection
- Projecting video clips
- Using special presentation modes

Before starting, make sure you’ve installed the wireless network module as described on page 52. You must also install the EMP NS Connection software as described on page 181 for each computer you want to connect to the projector. Then follow the steps in this chapter to start EasyMP, configure your projector and computer, and run EMP NS Connection.
Presenting Through a Wireless Network

Starting EasyMP

Before connecting to the projector, you have to switch it to EasyMP mode. Follow these steps:

1. Point the remote control at the projector and press the Power button.

2. Press the EasyMP button on the remote control to select EasyMP as the source.

You see this screen. The network settings appear in the lower left.

3. If you’ve already set up your computer and projector for the mode you want to use—Ad Hoc mode (also called computer-to-computer mode) or Access Point mode (also called infrastructure mode)—skip to “Projecting Over a Network” on page 81.

Otherwise, continue with the next section.

**note**

Use only the Epson 802.11a/b/g wireless module in the projector.

If you see a message asking you to insert a LAN or memory card, check to make sure your 802.11 a/b/g module is properly inserted (see page 52).
Configuring Basic Settings

You can give your projector a unique name, enable a projector keyword, or create a password for controlling the projector using your computer’s Web browser.

1. Press the Menu button, then choose Network and press Enter.
2. Choose Network Configuration and press Enter.
3. Choose Basic and press Enter.

   You see the following screen:

4. Make sure the projector has a unique name, so you can identify it when connecting to it from your computer.

   If you need to rename it, highlight the Projector Name text box then press Enter.
5. Press the pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

6. If you want to create a password for remote access to the projector, highlight Web Control Password, press Enter, and enter a password of up to 8 alphanumeric characters. When you’re done, highlight Finish and press Enter.

7. If you want to set up a security keyword so that only people who are in the same room as the projector can access it, turn Projector keyword on. When you connect to the projector, a randomized four-digit number or “keyword” is displayed on the screen. When prompted by NS Connection, enter the keyword on your computer to connect to the projector (see page 83).

8. When you’re done making these settings, select Return, select Setup complete, and then select Yes to confirm that you want to save the changes. Press Menu to exit the menu system.

Configuring the Connection

You can use NS Connection to connect to the projector and send images wirelessly in two modes: Ad Hoc mode or Access Point mode.

- **Ad Hoc mode** (computer-to-computer mode) lets you connect just one computer to the projector at a time; it’s easy to set up, and the only equipment you need is a computer with a wireless (802.11g, 802.11b, or 802.11a) network card or adapter, or a Macintosh with an AirPort® or AirPort Extreme card. When you
connect to the projector in this mode, your connection to other wireless networks or devices is broken; you can connect to the projector only.

- **Access Point mode** (infrastructure mode) lets multiple computers access the projector at the same time and easily trade off control over the projector. To use Access Point mode, you need a wireless (802.11a, 802.11b, or 802.11g) access point or an AirPort Extreme (or AirPort) base station, and one or more computers with wireless network cards or adapters.

Follow the instructions below for the mode you want to use.

**Using Ad Hoc Mode**

To use Ad Hoc (computer-to-computer) mode, adjust your projector and wireless card or adapter settings as described in this section.

**Configuring the Projector**

1. Press the **Menu** button, then choose **Network** and press **Enter**.
2. Choose **Network Configuration** and press **Enter**.
3. Choose **Wireless LAN** and press **Enter**.

You see this screen:

![Network settings screen](image)

**note**

Make sure you’ve installed the NS Connection software as described on page 181.

To connect to the projector over a wireless network, your computer must be running Windows 2000 or XP. Your Mac must be running Mac OS X 10.3 or later. See page 181 for complete system requirements for projecting wirelessly.

Access Point mode (infrastructure mode) is required to achieve transfer speeds up to 54MB/sec on an 802.11g network. Ad Hoc mode (computer-to-computer mode) limits network connections to 11MB/sec. This is a standard specification of 802.11g networking.
4. Make sure **Quick** is selected for the Connection mode. If not, use the Pointer button on the remote control to highlight **Quick**, then press **Enter** to select it.

5. If your network is using 802.11a, use the Pointer button on the remote control to highlight **802.11a**, then press **Enter** to select it.

6. If your computer’s network card supports an SSID or ESSID name (see page 63), highlight the **ESSID** text box, press **Enter**, and enter a name:

   Press the Pointer button to select individual letters; then press **Enter** to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press **Enter**. To toggle symbol settings or capital letters, highlight the option and press **Enter**. When you’re done, highlight **Finish** and press **Enter**.

   ![Keyboard with arrow and enter icons]

   Note that the ESSID is case-sensitive (if you enter the name in uppercase on the projector, you must type it the same way on the computer connecting to the projector).

7. When you’re done making these settings, select **Return**, select **Setup complete**, and then select **Yes** to confirm that you want to save the changes. Press **Menu** to exit the menu system.

Now you’re ready to set up your computer to project wirelessly. Go to “Configuring the Network Settings for Windows” below, or “Setting Up Your Mac for Ad Hoc Mode” on page 63.
Configuring the Network Settings for Windows

Before connecting to the projector, you need to make sure the settings for your notebook’s or PC’s network card match the settings you entered for the projector.

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon. You see a screen similar to this:

   ![Network Connections Window]

   Right-click and select Properties

   note
   On some Windows systems, you can right-click My Network Places or Network Neighborhood on the desktop and select Properties.

   Settings may vary, depending on your wireless network adapter. See the documentation for your adapter for more information.
2. Right-click the Wireless Network Connection icon and select Properties. You see a screen similar to this:

3. Click the Configure button.

4. Click the Advanced tab. You see a screen similar to this:
5. Check your wireless card or adapter device settings. (Depending on the type of card or adapter you’re using, some of the settings may be different than those listed here.)
   ■ Set the Network Type to 802.11 Ad Hoc.
   ■ Set the SSID to match the name you assigned to the projector’s ESSID.
   ■ Make sure Encryption is Disabled.

6. Click the General tab and make sure that your wireless card or adapter is enabled.

7. When you’re done, click OK to close the Properties dialog box.

Now you’re ready to connect to the projector. See “Projecting Over a Network” on page 81.

Setting Up Your Mac for Ad Hoc Mode
Your AirPort software is automatically configured to allow your Mac to detect both computer-to-computer (Ad Hoc) and Access Point networks.

Typically, you only need to select your projector’s ESSID from the AirPort status menu on the Mac menu bar. If you’re having problems detecting the projector, follow these steps:

1. From the Apple pull-down menu, select System Preferences.

2. Double-click the Network icon. You see the Network settings window.

**note**
When you connect in Ad Hoc mode, your connection to other wireless networks or devices is broken. If you need to remain connected to your wireless network, use Access Point mode, as described on page 65. Also, make sure you reconnect to your original wireless network when you are done using the projector.
3. Make sure Location is set to Automatic.

4. Select Network Port Configurations in the Show pull-down menu.

5. Under Port Configurations, select AirPort.

6. Click Apply Now. Then close the window.

7. Click the AirPort icon on the menu bar at the top of the Mac desktop. You see the AirPort status menu:

8. Check to make sure AirPort is turned on.

9. Select your projector’s ESSID.
**Using Access Point Mode**

To use Access Point (infrastructure) mode, first adjust your projector and wireless access point or AirPort base station settings as described in this section.

**Configuring the Projector**
1. Press the Menu button, then choose Network and press Enter.
2. Choose Network Configuration and press Enter.
   
   You see this screen:

   ![Network settings](image)

4. Make sure Advanced is selected for the Connection mode. If not, use the pointer button on the remote control to highlight Advanced, then press Enter to select it.

5. If your network is using 802.11a, use the pointer button on the remote control to highlight 802.11a, then press Enter to select it.

6. To enable your computer to find the projector on the network, you need to enter the SSID name of your access point or AirPort network in the ESSID text box. (The name of your AirPort
Presenting Through a Wireless Network

network may be different from that of your AirPort base station; select your base station in the AirPort Admin utility and click Configure to check the name of your network.)

Highlight the ESSID text box, press Enter, and enter a name:

Press the ⬆️ pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

Note that the ESSID is case-sensitive (if you enter the name in uppercase on the projector, you must type it the same way on the computer connecting to the projector).

7. If your access point assigns IP addresses automatically, turn on DHCP. Otherwise, turn off DHCP and enter the following information:

- **IP address**: Enter the IP address you want to assign to the projector. It must be formatted like other addresses on the network. The last section should be unique.

- **Subnet mask**: For example: 255.255.255.000, but this depends on how your network is set up.

- **Gateway address**: Enter the IP address that was assigned to the access point or AirPort base station when it was set up.

8. When you’re done making these settings, select Return, select Setup complete, and then select Yes to confirm that you want to save the changes. Press Menu to exit the menu system.
Now you’re ready to set up your computer for wireless projecting. Go to “Configuring the Network Settings for Windows” below, or go to “Setting Up Your Mac for Access Point Mode” on page 73. If you want to enable security options for your network, see page 75 to set up the option that your network uses on the projector.

Configuring the Network Settings for Windows
Before connecting to the projector, you need to make sure the settings for your computer’s wireless card or adapter match the settings you entered for the projector.

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon. You see a screen similar to this:

   ![Network Connections Window]

   Right-click and select Properties

2. Right-click the Wireless Network Connection icon and select Properties.
You see a screen similar to this:

3. Click the **Configure** button.
4. Click the **Advanced** tab. You see a screen like this:
5. Check your wireless card’s or adapter’s device settings. (Depending on the type of card or adapter you’re using, some of the settings may be different than those listed here.)

- Set the Network Type to **Infrastructure**.
- Set the SSID to match the name assigned to the access point (which should also match the projector’s ESSID).
- Make sure Encryption is **Disabled** if you have not set up encryption on the projector.

6. Click the **General** tab and make sure that your wireless card or adapter is enabled.

7. When you’re done, click **OK** to close the wireless properties dialog box.

8. Right-click the **Wireless Network Connection** icon again and select **Properties**. You see this screen:
9. Select Internet Protocol and click the Properties button. You see this screen:

![Image of Internet Protocol properties dialog box]

10. If your access point uses DHCP, select Obtain an IP address automatically. Otherwise select Use the following IP address and Use the following DNS server addresses, then enter the required information:

   - **IP address**: Type in the IP address you want to assign to the computer. It must be formatted like other addresses on the network. The last section must be unique.
   - **Subnet mask**: For example: 255.255.255.000, but this depends on how your network is set up.
   - **Default gateway**: Enter the IP address that was assigned to the access point when it was set up.
   - **Preferred DNS server/Alternate DNS server**: Enter the IP address of the DNS server(s) for your network.

11. When you're done, click OK.

12. Click the Wireless Networks tab.

   (If you don’t see this tab, you may need to enable your wireless card or adapter by clicking Configure to access the device.)
settings; then follow any instructions on the screen to enable the device.)

You see a screen like this:

13. Verify that you’ve enabled your computer’s connection to the access point. It should be listed with the small icon next to it, indicating a connection.

If it’s not listed, click **Configure** and type the name of your access point.

14. When you’re done making settings, click **OK** to close the dialog box.

Now you’re ready to connect to the projector. See “Projecting Over a Network” on page 81.
Checking the Gateway IP Address on Windows

If you’re entering IP addresses manually and need to find out the gateway IP address (the IP address of your access point), make sure the wireless connection to the access point is currently active, as described in the previous section. Then follow these steps:

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon. You see a screen similar to this:

   ![Network Connections Window](image)

   Right-click and select Status

2. Right-click the Wireless Network Connection icon and select Status.
3. Click the Support tab. The gateway’s IP address is listed as shown:

Gateway address

**Setting Up Your Mac for Access Point Mode**

Your AirPort software is automatically configured to allow your Mac to detect Access Point networks.

Typically, you only need to select your AirPort network name from the AirPort status menu on the Mac menu bar. If you’re having problems connecting to the projector, follow these steps:

1. From the Apple pull-down menu, select **System Preferences**.
2. Click the **Network** icon. You see the Network settings window.
3. Make sure Location is set to Automatic.

4. Select Network Port Configurations in the Show pull-down menu.

5. Under Port Configurations, select AirPort.

6. Click Apply Now. Then close the window.

7. Start the AirPort Admin utility. Select your base station, then click Configure.

8. On the AirPort tab, make sure your AirPort network name matches your projector’s ESSID. If not, enter the projector’s ESSID in the AirPort Network text box and click Update.

9. If you turned DHCP on in your projector’s advanced menu, click the Network tab and make sure the Distribute IP addresses checkbox is selected. If you need to select it, click Update.
10. Click the AirPort icon on the menu bar at the top of the Macintosh desktop. You see the AirPort status menu:

![AirPort status menu]

11. Check to make sure AirPort is turned on.
12. Select the name of your AirPort network.

### Using Wireless Security Options

You can use the following security options when connecting to the projector wirelessly: WEP encryption, WPA security, EAP-TLS certificate validation, or LEAP, EAP, or PEAP authentication. To set these security features up on your wireless network, see your documentation or get help from your network administrator. See the following sections to enable the security option on your projector:

- “Enabling WEP Encryption” below
- “Enabling WPA Security” on page 77
- “Enabling EAP, LEAP, or PEAP Authentication” on page 79
- “Enabling EAP-TLS Certificate Validation” on page 80

#### Enabling WEP Encryption

1. Press **Menu** on the projector remote. Highlight **Network** and then press **Enter**.
2. Choose **Network Configuration** and press **Enter**.
3. Highlight **Security**, then press **Enter**.
4. Press **Enter** to show the menu, then highlight **WEP** and press **Enter**.

5. For the WEP encryption setting, highlight **128Bit** or **64Bit** and press **Enter**.

6. For Format, highlight **HEX** to enable hexadecimal input or **ASCII** to enable text input, then press **Enter**.

7. If you chose **64Bit**, choose Key ID 1, 2, 3, or 4.

   Highlight the **Encryption key** text box that corresponds to the Key ID you selected, then press **Enter**. Press the 
   pointer button to select individual letters; then press **Enter** to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press **Enter**. To toggle symbol settings or capital letters, highlight the

---

**note**  
Text input for WEP encryption varies with different access points; check with your network administrator. Try **ASCII** first. If that doesn’t work, try **Text2 and then Text3**.
option and press Enter. When you’re done, highlight Finish and press Enter.

8. Check with your network administrator for directions on entering a key for your network, and follow these general guidelines:

- For 128 bit WEP encryption with hexadecimal input, enter 26 characters, from 0 to 9 and from A to F.
- For 64 bit WEP encryption with hexadecimal input, enter 10 characters, from 0 to 9 and from A to F.
- For 128 bit WEP encryption with ASCII or text input, enter 13 alphanumeric characters.
- For 64 bit WEP encryption with ASCII or text input, enter 5 alphanumeric characters.

9. When you’re done making these settings, select Return, select Setup complete, and then select Yes to confirm that you want to save the changes. Press Menu to exit the menu system.

**Enabling WPA Security**

1. Press Menu. Highlight Network and then press Enter.
2. Choose Network Configuration and press Enter.
3. Highlight Security, then press Enter.
You see the following screen:

4. Press **Enter** to show the menu, then choose **WPA-PSK(TKIP)** or **WPA-PSK(AES)** and press **Enter**.

Highlight the **PSK** (pre-shared key) text box and press **Enter**. Press the 🎮 pointer button to select individual letters; then press **Enter** to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press **Enter**. To toggle symbol settings or capital letters, highlight the option and press **Enter**. When you're done, highlight **Finish** and press **Enter**.

5. When you're done making these settings, select **Return**, select **Setup complete**, and then select **Yes** to confirm that you want to save the changes. Press **Menu** to exit the menu system.
Enabling EAP, LEAP, or PEAP Authentication

1. Press Menu. Highlight Network and then press Enter.
2. Choose Network Configuration and press Enter.
3. Highlight Security, then press Enter.

You see the following screen:

4. Press Enter to show the menu, then choose EAP-TTLS/MD5, EAP-TTLS/MS-CHAPv2, LEAP, PEAP/MS-CHAPv2, or EAP-FAST/GTC and press Enter.
5. Enter the user name and password that match the settings on your authentication server:
Highlight the **User name** text box and press **Enter**. Press the ⬆ pointer button to select individual letters; then press **Enter** to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press **Enter**. To toggle symbol settings or capital letters, highlight the option and press **Enter**. When you’re done, highlight **Finish** and press **Enter**.

- Highlight the **Password** text box and press **Enter**. Enter the password as you entered the User name.

6. When you’re done making these settings, select **Return**, select **Setup complete**, and then select **Yes** to confirm that you want to save the changes. Press **Menu** to exit the menu system.

**Enabling EAP-TLS Certificate Validation**

1. Press **Menu**. Highlight **Network** and then press **Enter**.
2. Choose **Network Configuration** and press **Enter**.
3. Highlight **Security**, then press **Enter**.
You see the following screen:

4. Press Enter to show the menu, then choose EAP-TLS and press Enter.
   The certificate information appears on the screen.

5. When you’re done making these settings, select Return, select Setup complete, and then select Yes to confirm that you want to save the changes. Press Menu to exit the menu system.

**Projecting Over a Network**

Once you’ve started EasyMP and set up your projector and computer in either Ad Hoc (Quick) mode or Access Point (Advanced) mode, or in the optional wired LAN mode, as described on page 136, follow these steps to start NS Connection and project over the network.

1. Make sure you’ve set up your projector (see page 56).

2. **Windows:** Select EMP NS Connection from the Start menu.
   
   **Mac OS X:** Double-click the EMP NS Connection icon in your Applications folder.
3. The first time you start NS Connection, you see this dialog box.
Choose a connection mode and click OK.

4. If you see a message asking you to disable the firewall, click Yes to make an exception for the projector and allow projection.

You see the screen below. (If you have previously started NS Connection, this may be the first screen you see.)
If the connection is working properly, you see your projector listed. If you have additional Epson projectors on the network, they are also listed, along with their status.

The status is indicated next to each projector’s name.

5. Once the name of your projector appears, select it and click Connect. If more than one projector is listed, you can select additional ones and connect to them (up to four) at the same time.

If the selected projector is already being used by another person, you can still connect to it (unless it is “locked”); doing so automatically disconnects the other user. If a projector is locked, you won’t be able to connect to it when it is in use.

If you don’t see the projector, follow the suggestions on page 84.

6. If you set up the projector to prompt you for a keyword before connecting, you see a screen like this one:

Type in the four-digit number displayed on the EasyMP Network screen and click OK.

7. Once the connection is established, you see your computer’s image transmitted to the screen, and a floating control bar on your computer desktop:

**note**

If a projector is in use and is “locked,” you won’t be able to select it.

To lock the projector from connection by other users while you are connected, click the Disable interrupt connection checkbox. De-select it to disable the lock and allow connection by other users.

If Microsoft PowerPoint is already running when you start the projection and you see a message that says you need to restart PowerPoint, close and reopen PowerPoint after starting NS Connection.
8. If necessary, you can drag the control bar out of the way on your screen.

9. When you’re done with your presentation, click **Disconnect** on the control bar.

**Solving Connection Problems**

If you don’t see your projector, check the following:

1. Make sure your wireless signal is strong enough to establish a connection. If you have a Mac, check the AirPort icon on the Mac menu bar. For Windows, see the documentation for your access point or wireless network card or adapter.

2. Make sure you’re trying to connect to the right network. In Windows, verify that you’ve enabled your computer’s connection to the access point or that your wireless card or adapter is enabled, and that its SSID matches the projector’s ESSID. In Mac OS X, check the AirPort status menu (click the AirPort icon on your menu bar) to make sure AirPort is turned on and the projector’s ESSID or your AirPort network is selected.

3. Make sure you aren’t projecting one of the EasyMP configuration screens. (You should see a message that the projector is ready to connect.) If you have to exit a configuration screen, restart NS Connection.

4. Make sure the ESSID for your projector matches the SSID for your wireless card, adapter, or access point. If you have an AirPort base station, make sure the projector’s ESSID matches the AirPort network name. Remember that the ESSID is case-sensitive.

5. Check the IP address for both your projector and your wireless card, adapter, access point, or AirPort base station. The first three segments of the IP address should be identical. The last segment of the projector’s IP address should be close, but not identical, to the last segment of the IP address for your wireless interface, access point, or base station.

6. Restart your computer and start NS Connection again.

---

**note**

*If none of these suggestions work, see the troubleshooting information beginning on page 173.*

**note**

*The AirPort network name may be different than the AirPort base station name. To check the network name, start the AirPort Admin utility, select your base station, and click Configure. Then click Show All Settings. The network name appears on the AirPort tab.*
7. If you still don’t see your projector, follow the instructions in “Connecting in Advanced Connection Mode” on page 86 to connect to the projector.

### Using the Control Bar

From the control bar, you can access these NS Connection features:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select Target" /></td>
<td>Displays the Select target projector dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stops projection of computer images while connecting to the projector.</td>
</tr>
<tr>
<td><img src="image" alt="Projector" /></td>
<td>The projector projects the computer image.</td>
</tr>
<tr>
<td><img src="image" alt="Pause" /></td>
<td>Pauses projection of computer images. Click again to restart projection.</td>
</tr>
<tr>
<td><img src="image" alt="Presentation Mode" /></td>
<td>Starts Presentation Mode for the selected projector. In Presentation Mode, only your slideshow images are projected. See page 93.</td>
</tr>
<tr>
<td><img src="image" alt="Projector Control" /></td>
<td>Displays the Projector Control screen, which allows you to enable A/V Mute, switch the PC source, or switch the video source.</td>
</tr>
<tr>
<td><img src="image" alt="Movie Sending" /></td>
<td>Starts Movie Sending Mode for projecting MPEG2 videos from your computer. See page 92.</td>
</tr>
<tr>
<td><img src="image" alt="Multi-screen Display" /></td>
<td>Allows you to set up Multi-screen display and see a preview of how the images will appear on each screen. See page 90.</td>
</tr>
<tr>
<td><img src="image" alt="Projector Settings" /></td>
<td>Displays the Projector Settings dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Disconnect" /></td>
<td>Disconnects the connection to the projector.</td>
</tr>
<tr>
<td><img src="image" alt="Change Buttons" /></td>
<td>Changes which buttons are displayed on the control bar.</td>
</tr>
</tbody>
</table>

**note**

Movie Sending Mode does not work with DVD movies.

Clicking one of the buttons on the control bar may cause a submenu to appear above the control bar.

When you’re done, click the arrow in the upper right corner to close the submenu.
Connecting in Advanced Connection Mode

1. Click Manual search on the NS Connection screen.

2. Enter the IP address or the projector name for the projector you want to connect to, and click OK.

The Projector is added to the EMP NS Connection screen.

If the search fails to find a projector with the specified IP address, the searching icon turns into a question mark. If this happens, run EasyMP on your projector (see page 56) to check the projector’s IP address, then repeat this step.

3. Click the projector you want to connect to and click the Connect button. If more than one projector is listed, you can select additional projectors and connect to them at the same time.
4. If you are prompted for a keyword, enter the four-digit number displayed on the EasyMP Network screen and click OK.

The computer’s image is transmitted to the projector and appears on the screen. See page 83 for details about using the floating control bar on your computer desktop.

**Enabling Network Security**

The projector includes the following network security options which you can enable for network projection:

- **Data encryption**
  Encode and transmit data. Even if data is intercepted, it cannot be deciphered. See page 88 to enable encryption.

- **Connection limitation (Authentication)**
  A user’s name and a password are registered in advance, which means that only the registered wireless port can connect to the network and prevents unauthorized third parties from connecting to the network.

- **Firewall**
  Prevents unauthorized computer access by closing ports that are not used. The security functions that can be used with this projector vary depending on the connection mode of the wireless LAN. Use the firewall function provided with your OS.

The security functions that can be used with this projector vary depending on the connection mode:

- **Quick Connection Mode**
  Encrypted communication

- **Advanced Connection Mode**
  Encrypted communication, WEP, WPA-PSK (TKIP), WPA-PSK (AES), EAP-TLS, EAP-TTLS/MD5, EAP-TTLS/MS-CHAPv2, PEAP/MS-CHAPv2, PEAP/GTC, LEAP, EAP-FAST/MS-CHAPv2, EAP-FAST/GTC

**note**

The authentication and firewall features are only effective when the access point for the connection destination supports the same functions.
Enabling Data Encryption

1. Click **Set options** on the main screen.

![Set options](image1)

2. Click the **General Settings** tab.

3. Select the **Encrypt communications** checkbox.

![Encrypt communications](image2)

4. Click **OK**.
**Enabling Network Security Options**

You need to enable network security including WEP, WPA, EAP, LEAP, or PEAP, or firewall settings on your network and on the projector (see page 75). For network setting details, follow the directions from your network administrator.

If using EAP, you need to make settings at the projector that match the authentication server settings. Check with your network administrator for details on RADIUS settings.
**Multi-screen Projection**

When using Multi-screen display, you can set each projector to display a section of the screen or image, to create a single image spanning a large area. Make sure the projectors are at least 3.6 feet apart to avoid overheating.

Here are some examples:

To set up multi-screen display in NS Connection, follow these steps:

1. Click **Use multi-display**.
2. Click Display properties.

3. Drag the monitor icons to arrange the positions of the displays.

4. Close the Display Preferences (Windows) or System Preferences (Macintosh), when you are done arranging the display numbers.
5. To allocate projectors to each display, choose a number from the menu under Display.

6. Click the **Connect** button when you are ready to project the image.

7. You can use the **Screen Preview** button on the NS Connection toolbar to check the image on each screen.

---

**note**

*Only MPEG1-Layer2 audio is supported. The maximum supported MPEG2 video resolution is 720 × 480 NTSC or 720 × 756 PAL (without audio).*

---

**Projecting Video Clips**

You can project full-screen MPEG2 video clips with audio in real time (30 frames per second). For best performance, advanced wireless mode, 802.11g, or 802.11a are recommended.

1. Click the **Movie Sending Mode** button on the NS Connection toolbar.

2. If you are connected to more than one projector, select the one you want to use for the video.
3. Click the Select file button. Locate the MPEG2 video you want to project and click Open.

![Movie Sending Mode](image)

4. Use the standard playback buttons on the screen to start, pause, rewind, and control other video functions.

5. When you’re finished projecting video, click the Close button on the screen.

**Using Special Presentation Modes**

Your projector provides several features that allow you to show presentation slides to your audience and hide other activity on your laptop. Both work with PowerPoint in Windows and Keynote® on Macintosh.

- Presentation Mode displays only slides to your audience and hides other activity on your computer.
- Presenter View lets you see your notes and slideshow controls while projecting your slides.

*note*

The video will be projected on the screen, but will not appear on the host computer.
Using Presentation Mode

In Presentation Mode, the projector shows a black screen (or an image of your choice) while you search for files or perform other activities on your laptop. When you start a PowerPoint (Windows) or Keynote (Mac) slideshow, the projector shows your slides.

1. Click the Presentation Mode button on the NS Connection toolbar. The projector displays a black screen with the Epson logo.
2. Open your presentation in PowerPoint or Keynote.
3. In Keynote, select Preferences. Set the Presentation Mode to Present on secondary display.
4. In PowerPoint, open the Slide Show pull-down menu and select Set Up Show. Set the Multiple monitors box to Display slide show on Monitor 2. Then click OK.
5. Start your slideshow. The projector displays your slides. When you finish your slideshow, the projector again displays a black screen.
6. When you want to exit Presentation Mode, click the Presentation Mode button on the NS Connection toolbar.

Using Presenter View

Presenter View allows you to see your PowerPoint notes and controls on your laptop while projecting only the presentation slides to your audience. Follow these steps to set up and use Presenter View:

1. Make sure you have at least one EPSON Virtual Display enabled.
   - If you did not enable Virtual Displays when you installed NS Connection, select EPSON Projector from Start > Programs or All Programs. Select Add-Remove EPSON Virtual Display, then check EPSON Virtual Display 1. If you see a message that the driver has not passed Windows Logo testing, click Continue Anyway. Then restart your computer.
2. Launch NS Connection as described on page 81.
3. Click Use multi-display, then click Display properties.

4. On the Display Properties screen in Windows, make sure your Epson Projector Virtual Display Driver is selected, then check Extend my Windows desktop onto this monitor and click OK.

In the Mac OS X Displays program, select the Arrangement tab and uncheck the Mirror Displays setting to deselect it.
5. Set your projector to Display 2 (or the Virtual Display Driver you selected in step 4) in NS Connection, then click **Connect**.

![NS Connection screenshot](image)

6. Open your presentation in PowerPoint or Keynote.

7. In Keynote, select **Preferences**.
In PowerPoint, open the Slide Show pull-down menu and select Set Up Show.

8. In Keynote, set the Presentation Mode to Present on secondary display.

   In PowerPoint, set the Multiple monitors box to Display slide show on Monitor 2 (or the monitor associated with your Epson Virtual Display) and check Show Presenter View. Then click OK.

9. Start your slideshow.

   The projector displays the slides, and your laptop displays your notes and controls.
Presenting Through a Wireless Network
Presenting from a USB Drive, Camera, or CompactFlash Card

The projector’s EasyMP PC Free feature lets you give presentations from a USB flash drive, digital camera, USB multicard reader, or CompactFlash card. You can play movies, display graphics, or play a scenario, a format that lets you create your own slideshow using PowerPoint files, image files, and MPEG videos.

When a CompactFlash card is inserted and the projector is on a network, you can also transfer files to the card over the network. See page 51 for instructions.

This chapter covers the following:

- Presenting files from a USB drive or CompactFlash card
- Presenting image files from a digital camera
- Creating a slideshow on the fly
- Creating a scenario
- Transferring your scenario to a USB drive
- Presenting scenarios
- Supported file formats

**note**

Also make sure you’ve installed the EMP SlideMaker software (available for Windows only), as described on page 182.
Presenting Files From a USB Drive or CompactFlash Card

This section explains how to project individual image or movie files from a USB hard drive, flash memory drive, or CompactFlash card using EasyMP. See page 118 for a list of the supported file formats.

Follow these steps to display images or play movies:

1. Connect your external drive or insert your CompactFlash memory card (see page 50).
   
   If you are using an external hard drive, plug in its power cord.
2. Turn on the projector, if it is not already on.
3. Select EasyMP as the source by pressing the EasyMP button on the remote control.
   
   If you have more than one card inserted in a multicard reader, use the pointer button on the remote control to select the card you want to use and press Enter.

   You see your files displayed on the screen:

   ![Image of files displayed on the screen]

4. If your files are in a folder, use the pointer button on the remote control to select the folder and press Enter.
   
   If your files are not in a folder, skip to step 6.
5. Select **Open Folder**. You see your image files when the folder opens.

6. Position the cursor on the movie or image file you want to project and press **Enter**.

7. Select **View Image** or **Play Movie**.
   
   If you selected an image, it is projected on the screen. If you want, you can press a side of the 🔄 pointer button to rotate the image while you’re viewing it.
   
   If you selected a movie, it begins playing. You can use the 🔄 pointer button to control playback, as indicated on the bottom of the screen.

To stop viewing images, select **Exit** at the top of the screen and press **Enter**.

---

**Presenting Image Files From a Digital Camera**

This section explains how to project individual image files on your digital camera using EasyMP PC Free mode and a USB cable connection.

Follow these steps:

1. Connect your digital camera (see page 50).

2. Turn on your digital camera.

3. Turn on the projector, if it is not already on.

4. Select EasyMP as the source by pressing the **EasyMP** button on the remote control. If your camera complies with the DCIM standard, you’ll see a **DCIM** folder appear on the EasyMP PC Free screen.

5. Use the 🔄 pointer button on the remote control to position the cursor on the folder and press **Enter**.

6. Select **Open Folder** in the drop-down menu. When the folder opens, you see another folder with your manufacturer’s name.

---

**note**

If you exit the PC Free mode on the projector, disconnect and re-connect your USB device before starting again.

---

**note**

Most digital cameras also have the ability to play internal slideshows. Depending on the kind of cable you have, you can connect a camera with a video or A/V out port to the projector’s **Video** or **S-Video** port and transmit your camera’s slideshow directly to the projector. You must press the **Video** or **S-Video** button on the remote control to select the correct signal source. See pages 43 or 44 for details.
7. Position the cursor on the folder and press **Enter**.

8. Select **Open Folder**. You see your image files when the folder opens.

9. Position the cursor on the image file you want to project and press **Enter**.

10. Select **View Image**. The image is projected on the screen. If you want, you can press a side of the \( \textcircled{2} \) pointer button to rotate the image while you’re viewing it.

To stop viewing images, select **Exit** at the top of the screen and press **Enter**.

---

**Creating a Slideshow on the Fly**

If you have a folder containing an assortment of images, you can display them as a slideshow. See page 118 for a list of the supported file formats.

**Displaying the Slideshow**

First make sure the images are stored in a folder on the USB drive or CompactFlash memory card. Then follow these steps:

1. Connect your external drive (see page 50) or insert your CompactFlash memory card (see page 51).
   
   If you are using an external hard drive, plug in its power cord.

2. Turn on the projector, if it is not already on.

3. Select EasyMP as the source by pressing the **EasyMP** button on the remote control.
   
   If you have more than one card inserted in a multicard reader, use the \( \textcircled{2} \) pointer button on the remote control to select the card you want to use and press **Enter**.

---

**note**

Make sure your camera shows up on your desktop as a drive letter. If it does, it is probably a USB mounted device and will work with the projector software. The EasyMP software does not support TWAIN-compliant digital cameras.
You see your files displayed on the screen:

![Image of files on screen]

4. Use the ⬤ pointer button on the remote control to highlight the folder containing your images and press Enter.

5. From the pop-up menu, use the pointer to select Play Slideshow and press Enter. (Or highlight the Slideshow button at the bottom of the screen and press Enter.) The images contained in the folder are presented as a slideshow.

Use the remote control to run the slideshow as described in the next section.

**Controlling Your Slideshow**

While your slideshow is running, use the remote control as follows:

- Press Enter or Page down to display the next slide or image, or to begin playing a movie.
- Press Page up to display the previous slide or image, or to replay a movie.
- Press the appropriate side of the ⬤ pointer button to rotate a slide or image on the screen.
- To exit the slideshow at any point, press the Esc button. Select Exit and press the Enter button.
Changing Timing and Other Settings

For each folder on the USB drive or memory card, you can set the display timing for your slides and change several other display settings.

1. Select the folder containing the images for the slideshow settings you want to change and press Enter.

2. From the drop-down menu, use the pointer to select Option and press Enter.

   You see this screen:

3. Use the pointer button to select from the following settings. After making a selection, press Enter to save the change.

   - Mode switching
     
     Lets you choose the mode to use when presenting slideshows, movies, or images, or editing a scenario on the projector.

     In Guide mode, a drop-down menu appears whenever you select an item and press Enter.

     In Quick mode, selecting a scenario, movie, or image file and pressing Enter starts the presentation; selecting a folder and pressing Enter opens the folder. To access the menus in Quick mode, press the Esc button.
Presenting from a USB Drive, Camera, or CompactFlash Card

■ Display order
Let you choose between displaying alphabetically by file name or by image file date.

■ Continuous Play
Determines whether to repeat the display of images in the folder.

■ Screen switching time
Sets the display time for each image. Choose No if you want to change slides manually.

■ Effect
Lets you choose from various transitions between slides, such as Dissolve or Wipe.

4. When you’re done, highlight OK and press Enter. Your changes are permanently saved with each folder—even if you turn off the projector or disconnect the drive or camera.

Creating a Scenario

A scenario is a combination of images, movies, and/or audio files that you can present from a USB drive. The easiest way to create a scenario is to drag and drop a PowerPoint file on the EMP SlideMaker2 icon on your desktop. This automatically converts the file to a scenario that you can save to the drive. Use this method if you have an existing PowerPoint presentation that you want to transfer to the projector.

If you prefer, you can create a scenario from scratch by combining a selection of PowerPoint slides, other graphics, and even movies (see page 107).

note
To create a scenario, you need a USB drive connected to your computer. Also make sure you’ve installed the EMP SlideMaker software (available for Windows only), as described on page 181.
Converting a PowerPoint File to a Scenario

Follow these steps to convert a PowerPoint file to a scenario. Once the scenario is created, you can set up transitions as described on page 111.

1. Make sure the EMP SlideMaker program is closed.

2. Locate the PowerPoint file you want to use in My Computer or Windows Explorer.

3. Drag the file icon on top of the EMP SlideMaker2 icon on your desktop.

4. When you see a message about file conversion, click Continue.

5. When you see the next message, click Start.

EMP SlideMaker 2 starts and your PowerPoint slides open one-by-one as they are converted. Do not interrupt this process or your PowerPoint file won’t be completely converted.

6. When the scenario is done, click on the screen. The slideshow closes and you see the following message:

7. Connect a USB device and browse to the drive, then click OK to transfer your scenario file.

When the transfer is complete, you see a question asking whether you want to autorun the scenario. See page 114 for instructions on the autorun setting.
Creating a Scenario from Scratch

Use this method when you want to create a scenario from a selection of PowerPoint slides, graphics, or movie files. You'll need to set up your scenario file and folder, build the scenario, set up transitions, and check the scenario.

Setting Up the Scenario File and Folder

1. Double-click the EMP SlideMaker2 icon on your computer's desktop (or click Start > Programs or All Programs > Epson Projector > EMP SlideMaker2).

You see the EMP SlideMaker 2 screen with the Properties window open as shown:

2. Type a name for your scenario file and folder that's easy to remember, using up to eight capital letters and numbers. Then select from the following options:

- The default location for the scenario file and folder is in the \Program Files\EMP SlideMaker2 folder. Click Browse to choose a new location.

note
The scenario name you enter is also the name of the folder for your scenario on your hard drive.
Click **Configure BGM(W)** to play an audio file during the scenario. A selection screen appears letting you choose a .WAV file. After you select the file you want, click the arrow button to the right of the option to play it.

- The Background Color appears around images that don’t fill the entire screen area. Select a new color, if desired.
- Select the Image Quality for imported PowerPoint slides. Higher-quality images look better on the screen but may take longer to appear.

3. Click **OK**. You see the EMP SlideMaker 2 screen.

Continue with the instructions in the next section to build your scenario.

**Building a Scenario from Different Files**

You can build your scenario from any of the following file types, either alone or in combination with other file types:

- PowerPoint slides, version 2000 through 2003 (file names have PPT extension)
- JPEG files (with JPG extension)
- Bitmap files (with BMP or DIB extension)
- Movie files (with MPG extension); must be MPEG 2 (MPEG1 is not supported)
Follow these steps:

1. Use the navigation tools on the left side of the EMP SlideMaker 2 screen to locate the files you want to include in your scenario.

   PowerPoint, JPEG, bitmap, and movie files appear as icons in the file window.

2. Click the icon for each file that you want to preview. The preview appears in the thumbnail preview window. If you click a PowerPoint icon, thumbnail images are generated for all the slides in the PowerPoint file. If you click a movie file, an illustration of a filmstrip appears.

   **Note**
   
   Thumbnail previews for PowerPoint slides will not appear if PowerPoint is not installed on your computer.
3. Drag and drop the files you want to include in your scenario from either the file window or thumbnail window into the scenario window. (You can also double-click a thumbnail to add the file to the scenario.)

4. Continue dragging files into the scenario window to build your presentation. Each slide appears in a numbered cell. The cell background color varies according to the type of file in the cell.

5. If you want, you can make changes to the scenario:

   ■ To rearrange cells, drag and drop them as necessary within the scenario window.

   ■ To delete a cell, right-click the cell and select Cut.

   ■ To check the animation for a slide, click its cell. A section appears at the bottom of the scenario window displaying each animation operation. (Slides using animation have an .EMA extension.)

   Transition effects created in PowerPoint look smoother than those you add with EMP SlideMaker 2.

   Unless you change the transition setting, your slides will automatically advance after 30 seconds.

   You can also create transitions between slides, as described in the next section.
6. When you’re done, click the **Save** button or choose **Save** from the File menu. Then see page 114 to transfer the scenario to your USB drive or CompactFlash card.

**Setting Up Transitions**

EMP SlideMaker 2 lets you set your slides to advance manually or automatically after a specified period of time. You can also choose from a variety of transition effects between slides.

1. Click the cell or cells for which you want to set up in the scenario window.

   To select more than one cell, hold down the **Ctrl** key while you click. To select all the cells, choose **Select All** from the Edit menu. Selected cells turn yellow.

2. Right-click the selected cell or cells. The cell menu appears:
3. Click **Cell Properties**. You see this dialog box:

4. Choose how you want to advance to the next cell.
   - If you want to change slides manually using the remote control, select **On mouse click**.
   - If you want your slides to advance automatically, set the timing in the **Automatically after** box. You can set any length of time between 1 and 1800 seconds (30 minutes). Even if you select this setting, you can still change slides manually using the remote control.

5. To add a transition effect (such as a dissolve, fade, or wipe), select one of the **Animation Effects** settings and choose a **Direction** setting, if applicable.

6. When you’re finished setting up the transition for the selected cell or cells, click **OK**.

7. Click the **Save** button or choose **Save** from the File menu.

Continue with the steps in the next section when you’re ready to transfer your scenario to a USB drive.

---

**note**

Transition effects look smoother when you create them in the PowerPoint file itself and use that file to create a scenario.
Checking Your Scenario

You can play your scenario before you transfer it to a USB drive to make sure it looks and sounds the way you want it to.

1. Use the navigation tools in the folders window to locate the scenario file you want to review. Click the file, then select File > Open to open the scenario.

2. Click Scenario Option(s) > Scenario Preview. The Scenario Preview window displays.

   If the scenario is set to advance automatically (see page 112), it begins to play. If it is set to advance each time you click the mouse, click the play button to go through your slides one by one.

3. Use the controls in the Scenario Preview window to pause, stop, rewind, or fast forward your scenario. When you’re done, close the window.
Transferring Your Scenario to a USB Drive or CompactFlash Card

Once your scenario is saved, you can transfer it to a USB drive or CompactFlash memory card. Be sure to use the transfer process described below to ensure that the scenario plays properly:

1. Connect the USB drive. If you are using a CompactFlash card, insert it in your computer or insert it in a card reader and connect the card reader to your computer.
2. Start EMP SlideMaker 2 (see page 107).
3. Use the navigation tools in the folders window to locate the scenario file you want to review. Click the file, then select File > Open to open the scenario.
4. From the Scenario Option(s) menu, choose Send Scenario. You see a drive selection window:

   ![Drive Selection Window]

5. Choose the drive (and folder) and click OK.
6. Click OK again to confirm. Your scenario is transferred to the location you specified.

Once the scenario is transferred, you see this message about your scenario’s autorun setting:

![Autorun Setting Message]

**note**

Don’t use Windows to copy the scenario to your USB drive or memory card, or it may not play properly.

You must connect the USB drive (or card reader) before you select Send Scenario from the Scenario Option(s) menu. If you don’t, you won’t be able to see the drive in the drive selection window. If this happens, close and restart EMP SlideMaker 2.
The autorun setting means that the scenario will start playing whenever the projector is turned on (with the drive connected to the projector).

7. Do one of the following:

■ If you don’t want the scenario to run automatically, click Cancel. Skip to step 11 to remove the drive and insert it in the projector.

■ If you want it to run automatically, click OK and continue with the following instructions.

You see the Edit Autorun window:

8. To set a scenario to run automatically, select it from the list on the left side of the screen and use the `>` arrow button to move it to the list on the right.

9. Click the Revive box if you want your scenario to repeat continuously. Clear the checkbox if you want it to play only once.

10. When done, click OK.

11. Disconnect the USB device or card reader, or remove the CompactFlash card. See your computer’s documentation if you need instructions. If you’re using Windows XP, 2000 or Me, you may first need to click an icon to stop or disconnect the drive.

**note**

If more than one scenario is set to run automatically, they will play in the order listed on this screen.
Presenting Scenarios

Before you begin, connect the USB drive (see page 50) or insert the CompactFlash card containing the scenario to your projector (see page 51).

The follow these steps to present your scenario:

1. Turn on the projector, if it’s not already on.
   - If your scenario is set to autorun, it will start as soon as the projector warms up.
   - If your scenario is not set to autorun, you need to start it manually. Continue with the following steps.

2. Select EasyMP as the source by pressing the EasyMP button on the remote control. You see a screen like the one below.

![Scenario Display](image)

JPEG files are displayed as thumbnails. Other files or folders are displayed as icons. A scenario icon identifies a scenario file.

3. Use the pointer button on the remote control to highlight your scenario file and press Enter. A drop-down menu appears under the scenario.

4. Use the pointer button to select Play Scenario and press Enter. In a moment, your scenario begins playing.
Controlling Your Scenario

While your scenario is running, use the remote control as follows:

- Press Enter or Page down to display the next animation, slide, or image, or to begin playing a movie.
- Press Page up to display the previous slide or image, or to replay a movie.
- Press the appropriate side of the pointer button to rotate a slide or image on the screen.
- To exit the scenario at any point, press the Esc button. Select Exit and press the Enter button.

note

Even if your scenario is set to change slides automatically, you can still change slides manually as described here.
### Supported File Formats

The following file types may be projected from a digital camera, external hard drive, flash memory drive, or CompactFlash card:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario</td>
<td>.sit</td>
<td>These are scenario files created using the EMP SlideMaker 2 program that is included with the projector.</td>
</tr>
<tr>
<td>Graphics</td>
<td>.bmp</td>
<td>Images with a resolution greater than 1024 x 768 cannot be projected.</td>
</tr>
<tr>
<td></td>
<td>.gif</td>
<td>Images with a resolution greater than 1024 x 768 cannot be projected.</td>
</tr>
<tr>
<td></td>
<td>.jpg</td>
<td>Projection is not possible for CMYK color formats, progressive formats, and images with a resolution in excess of 8192 x 6144.</td>
</tr>
<tr>
<td></td>
<td>.png</td>
<td>Projection is not possible for images with a resolution in excess of 1024 x 768.</td>
</tr>
<tr>
<td>Movie</td>
<td>.mpg</td>
<td>MPEG2-PS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The reproducible audio format is MPEG-1 Layer 2. Linear PCM and AC-3 audio cannot be played back, but MPEG contents with no sound can be played.</td>
</tr>
<tr>
<td></td>
<td>.mov</td>
<td>QuickTime® format Motion JPEG files.</td>
</tr>
<tr>
<td>DPOF</td>
<td>.mrk</td>
<td>For DPOF version 1.10, only files named AUTPLAYx.mrk (where x is a number between 0 and 9) can be projected.</td>
</tr>
</tbody>
</table>

Files with the extension JPEG and MPEG can’t be projected. Rename or save files as JPG or MPG. Files with high compression will not look good. Movie files may not look as good from media with a slow access speed.
Fine-Tuning the Projector

You can use the projector’s on-screen menus to adjust the image, sound, and other features. This chapter covers the following information:

- Using the menu system
- Adjusting the image
- Adjusting signal settings
- Customizing projector features
- Using the projector security features
- Customizing power and operation
- Multi-screen color adjustment
Using the Menu System

You can use the remote control or the projector’s control panel to access the menus and change settings. Follow these steps:

1. To display the menu screen, press the **Menu** button on the remote control or on the projector.

You see a menu screen similar to the one below:

The menus are listed on the left and the options available for the highlighted menu are shown on the right.

2. Use the **pointer** button on the remote control (or the navigational buttons on the projector) to scroll through the menu list. When you’ve highlighted the desired menu, press the **Enter** button to select it.

3. Once you’ve selected the menu, use the **pointer** button to scroll through the list of options. (Some of the options may be grayed out or unavailable, depending on the selected source.)
4. After highlighting the option you want to adjust, use the pointer button to change the setting. In some cases, you may have to press the Enter button to view a sub-screen for changing the setting.

- Press the left or right side of the pointer button to adjust a slider bar.
- To select from two or more settings, use the pointer button to highlight the desired setting and press Enter.

5. After changing the settings, press the Esc button to save your changes and return to the previous menu (or press it repeatedly to exit the menu system).

You can also press the Menu button to exit.

**Restoring the Default Settings**

You can use the menu system’s Reset options to restore the factory-default settings for all the settings listed in a specific menu, or all the settings in all menus.

To restore the settings in a specific menu, enter the menu whose settings you want to change, select Reset, and confirm as needed. (The example below shows how to reset the Image menu.)

To restore all the projector settings to their factory-default values, select the Reset menu, highlight Reset All, and press Enter.

---

**note**

When you select Reset All in the Reset menu, it does not reset the Computer Input, User’s Logo, Multi-screen, Language, Lamp Hours, or Network settings.
Adjusting the Image

You can use the Image menu to adjust the brightness, sharpness, color, tint, and contrast.

1. Press the Menu button on the projector or remote control and select the Image menu. You see the Image menu screen.

2. Use the pointer button to highlight the desired option, then adjust it as needed:

- Color Mode
  Lets you quickly adjust the color and brightness for various environments. Use either the remote control or the Color Mode setting in the Image menu. You can save a different setting for each source. Select from these settings:

  Game: Ideal for use in bright rooms and when playing video games, this mode produces the brightest images and most vivid colors.

  Presentation: For making presentations with color materials in bright rooms.

  Text: For making presentations with black-and-white materials in bright rooms.

  Theatre: For watching movies in a darkened room; gives images a natural tone.

  Photo: For vivid, high-contrast still images in a bright room.

  Sports: For vivid TV images projected in a bright room.

*note*

The available settings vary depending on the input source selected.
sRGB: For matching the color palette of standard sRGB computer displays.

Blackboard: For projecting accurate colors on a green chalkboard (adjusts the white point).

Customized: For manual color adjustment (see below).

- **Brightness**
  Lightens or darkens the overall image.

- **Contrast**
  Adjusts the difference between light and dark areas.

- **Color Saturation**
  Adjusts the color depth of the image.

- **Tint**
  Adjusts the balance of green to magenta in the image.

- **Sharpness**
  Adjusts the sharpness of the image.

- **Abs. Color Temp.**
  Sets a color temperature between 5000 and 10000 °K. (Not available if sRGB is selected as the Color Mode setting.)

- **Color Adjustment**
  Adjusts the color values. For Customized color mode, select RGBCMY to adjust individual red, green, blue, cyan, magenta, and yellow hue and saturation values. For other color modes, RGB may be selected to adjust red, green, and blue hue and saturation values. (Not available if sRGB is selected as the Color Mode setting.)

---

**Six-Axis Color Adjustment**

For special projection material, such as high-quality photographs or artwork, you can adjust the hue and saturation for six different color axes.

1. Follow the instructions on page 122 to open the Image menu and select Color Mode.
2. Press the Enter button to select Customized, then press Esc to return to the Image menu.

3. Select Color Adjustment and press Enter. You see hue and saturation controls on the screen for six colors: RGBCMY (red, green, blue, cyan, magenta, and yellow).

4. Select the color axis you want to adjust and press Enter. You see color controls for hue and saturation.

Hue changes the balance of color, and saturation changes the strength of the color.

5. Use the pointer button to adjust the hue and saturation. You see the adjustments reflected on the screen. When you are satisfied with the color, press Esc.

6. Repeat steps 4 and 5 for each color axis you want to adjust.

You may need to readjust the color as the lamp in your projector changes over time.

**Adjusting Signal Settings**

Although the projector normally detects and optimizes the input signal automatically, you can use the Signal menu to make manual adjustments. In addition to changing the position of the projected image, you can correct tracking and sync for computer images, or change the aspect ratio to widescreen format for video images.

1. Press the Menu button and select the Signal menu.

You see a screen similar to one of those below. (The settings will be different depending on the source you are projecting from.)
2. Use the pointer button to highlight the desired option, then adjust it as needed:

- **Auto Setup**
  Leave this setting On to automatically optimize computer images. Turn it off if you want to save adjustments you have made to the Tracking, Sync, and Position settings.

- **Tracking**
  Adjust this value to eliminate vertical stripes in computer images.

- **Sync**
  Adjust this value if computer images appear blurry or flicker.

- **Progressive**
  For composite video and S-video only. Turn this setting On to convert interlaced signals into progressive signals (best for still images). Leave the setting Off for moving images.

- **Position**
  If the image is slightly cut off on one or more sides, it may not be centered exactly. Select this setting and use the pointer button to center it.

- **Computer1 Input**
  Computer2 Input
  If the colors don’t look right on the Auto setting, select the setting for the type of equipment you’ve connected to the Computer1 or Computer2 port:
  
  RGB: For a computer or RGB-video connection.
  
  Component: For a video player that outputs a component video signal (with connectors labeled Y/Cb/Cr or Y/Pb/Pr).

- **Video Signal**
  Leave this setting at Auto unless you are using a 60-Hz PAL system (then select PAL60).

- **Resize**
  Choose an aspect ratio of either 4:3 or 16:9. For videos, you can also select 16:9 (Up) or 16:9 (Down) to accommodate subtitles or supertitles. Normal is the default setting for a computer connection.

---

**note**

You can also use the remote control’s Auto button to automatically reset the projector’s Tracking, Sync, and Position settings. See page 171 for details.
Customizing Projector Features

You can use the Settings menu to lock the buttons on the projector, adjust audio volume, and customize several other features.

- **Keystone**
  Adjusts the shape of the image if the projector has been tilted upward or placed at an angle to the screen.

  Select H/V-Keystone to correct horizontal and vertical keystone distortion, or to turn Auto V-Keystone on or off (see page 26).

  Select Quick Corner to adjust the shape and position of the projected image (see page 25).

- **Operation Lock**
  Lets you disable all of the buttons on the projector except the Power button. See page 131 for more information.

- **Pointer Shape**
  Lets you choose from three pointer shapes. See page 33 for more information.

- **Brightness Control**
  Lets you select from two levels of brightness. The Low setting reduces power consumption and noise, and extends the lamp’s operating life.

- **Volume**
  Raises or lowers the volume of the projector’s speaker.

*note* You can also adjust the volume using the remote control.
Remote Receiver
Deactivates the projector’s front and/or back sensors that detect signals from the remote control. Use this setting to prevent use of the remote control or to stop interference from bright fluorescent lights.

Test Pattern
Displays a test pattern for use when adjusting the zoom and focus, and when performing keystone correction.

Using the Projector Security Features

To prevent unauthorized use of the projector, you can do the following:

- Assign a password. You can use the password to prevent the projector from being turned on, prevent your custom startup screen from being changed, and lock network settings.

- Create a custom screen that is displayed at startup and/or when the A/V Mute button is pressed. The screen can be locked with a password to discourage theft and provides a way to identify the projector should it be stolen. See page 129.

- Disable the projector’s buttons; this is useful, for example, if you’re projecting in a classroom and you want to ensure that no one touches the projector’s buttons while you’re using the remote control. See page 131.

Enabling Password Protection
The default setting for the password is 0000. Follow these steps to create a new password:

1. Press the Freeze button on the remote control for about five seconds.
You see this screen:

2. Use the pointer button to select **Password** and press **Enter**.

3. When you see a message asking if you want to change the password, select **Yes** and press **Enter**.

4. Hold down the **Num** button on the remote control and use the numeric keypad to enter a four digit password. (The default setting is 0000.)

5. When you see a confirmation message, reenter the password. Then press the **Menu** button to exit the screen.

To set security options, access the Password Protect screen as described above, and then turn on any of the following options:

- **Power On Protect** to prevent unauthorized use of the projector. After the projector is plugged in and turned on, you must enter a password to use the projector. For details, see page 129.

- **User’s Logo Protect** to prevent your custom screen and display settings from being changed. None of the User’s Logo features in the Extended menu can be changed when the User’s Logo Protect function is enabled. For details on creating a custom screen, see page 129.

- **Network Protect** to lock the Network settings in the menu system (see page 57).
Starting the Projector with a Password

When the password function is enabled, you see this screen when you plug in and turn on the projector:

Hold down the Num button on the remote control and use the numeric keypad to enter the four digit password. The password screen closes and projection begins.

If the password is not correct, you see a message prompting you to re-enter the password. If you enter an incorrect password three times in succession, you see the message The projector’s operation will be locked and the projector switches to standby mode. Disconnect the projector’s power cord from the electrical outlet, reconnect it, and turn the projector back on.

When you see the Password screen again, you can try to enter the correct password.

If you enter an incorrect password 30 times in succession, the projector remains locked and you must contact Epson to unlock it.

If you have forgotten the password, contact Epson with the request code number that appears in the Password screen for assistance. See “Where To Get Help” on page 178.

Creating Your Own Startup Screen

You can transfer any image from your computer or video source to the projector and then use it as your startup screen. You can also use it as the screen displayed when the projector is not receiving a signal or when you press the A/V Mute button. The image can be a company logo, slogan, photograph, or any other image you want to use.
Capturing the Image

Start by displaying the image you want to use from either a computer or video source, such as a DVD player or digital camera. Then follow these steps to capture the image and transfer it to the projector:

1. Press the **Menu** button on the remote control, highlight the **Extended** menu, and press **Enter**.

2. Highlight **User’s Logo** and press **Enter**.

3. When you see a message asking **Choose this image as the user’s logo?**, select **Yes** and press **Enter**. A selection box displays over the image.

4. Use the ( Vimeo pointer button to select the area of the image you want to use. Then press **Enter**.

5. When you see the message **Select this Image?**, highlight **Yes** and press **Enter**.

6. Use the arrow buttons to select a zoom factor (display size) and press **Enter**.

7. When the message **Save this image as the user’s logo?** appears, select **Yes** and press **Enter**. Saving the logo may take a few moments. Do not use your projector, remote control, or video source while the logo is being saved.

8. When you see the message **Completed**, press **Menu** to exit the menu system.

---

**note**

When you choose an image for the user’s logo, it erases any previously used image. You can save an image up to 300 × 400 pixels in size.
Choosing When to Display the Image

After your image is saved, you can set it to display as the startup screen, the screen you see when there’s no signal, or the screen you see when you press the A/V Mute button (see page 31).

1. Press the Menu button, highlight the Extended menu, and press Enter.
2. Select Display and press Enter.
3. Choose from these display options:
   - Set Display Background to Logo to display your image when there is no signal.
   - Set Startup Screen to On to display your image when the projector is warming up.
   - Set A/V Mute to Logo to display your image when you press the A/V Mute button.
4. When you’re finished, press Menu to exit.

Disabling the Projector’s Buttons

When you enable the Operation Lock function, you can lock all the projector’s buttons, or all buttons except the Power button. The remote control can still be used to operate the projector.

1. Press the Menu button, highlight the Settings menu, and press Enter.
2. Select Operation Lock and press the Enter button.
3. Select Full Lock (to lock all projector buttons) or Partial Lock (to lock all buttons except the Power button) and press Enter.
4. Select Yes and press Enter to confirm the setting.
5. Press the Menu button to exit.

To disable the Operation Lock function, select Off in the Operation Lock menu. Or press and hold the Enter button on the projector’s control panel for 7 seconds. A message is displayed and the lock is released.

*note*

You can lock these settings to prevent them from being changed without a password (see page 127).
Customizing Power and Operation

You can use the Extended menu to customize the way the projector displays images, enable quick startup, turn sleep mode on or off, and customize other projector operations.

- Display
  Use this setting to turn off the display of messages, change the background color, enable logo display, or turn off the startup screen display.

- User’s Logo
  Create a custom startup screen, as described on page 129.

- Projection
  Select **Front** (to project from the front of a screen and right side up), **Front/Ceiling** (when the projector is mounted upside-down from the ceiling), **Rear** (to project from behind onto a transparent screen), or **Rear/Ceiling** (to project from behind onto a transparent screen when the projector is mounted upside-down from the ceiling).

- Operation
  Enable **Direct Power On** if you want to have the projector start when the power cable is connected (without pressing the **Power** button). Enable **Sleep Mode** if you want to have the projector turn off automatically if it is idle (and no signal is received) for 30
minutes or when the A/V mute slide (lens cover) is closed. Enable **High Altitude Mode** when you are using the projector above 4900 ft (1500 m).

- **Standby Mode**
  Select **Network On** to enable the projector to be monitored over a network when it is in standby mode (the power light is orange).

- **USB Type B**
  Select **Easy MP** to project your computer’s display through the projector’s Type B USB port (see page 39). Choose **Wireless Mouse** if you want to be able to use the remote as a wireless mouse for a USB-connected computer (see page 40).

- **Projector ID**
  Lets you assign a numeric ID to each projector. When you are using multiple projectors, you can use the ID to select the one you want to operate with the remote control. See page 35 for instructions.

- **Multi-screen**
  Use this option if you want to color-match two or more projectors that are being used to display images near each other, or you are using the multi-screen feature to project from one source (one image) with multiple projectors (see page 90). You can make image adjustments at each of five adjustment levels. First choose an **Adjustment Level** and then adjust the settings for each level: **Brightness Correct.** to adjust the brightness, and **Color Correct.** to adjust the balance between red and green, or blue and yellow. See page 134 for more information about multi-screen color adjustment.

- **Language**
  Select from nine languages to be used for the projector menus.

---

**note**

If Direct Power On is enabled, the power cable is connected, and a power outage occurs, the projector will start when the power is restored.

Do not use the projector at altitudes above 7500 ft (2,286 m).
Multi-screen Color Adjustment

You can match the color of projected images when two or more projectors are being used to display images near each other, or when you use the multi-screen feature to project from one source (one image) as described on page 90. For each screen, you can set five levels of brightness and color correction.

1. Before starting, you may want to assign a numeric ID to each projector. This lets you use the remote control to select the projector you want to adjust. See page 35 for instructions.

To match the display colors as closely as possible, make sure that all the projectors are set to the same color mode before starting. See page 122 for instructions.

2. Press the Menu button on the remote control. You see the projector’s menu screen.

3. Select Extended > Multi-screen.

4. Start by setting the Adjustment Level to 1 for two projectors. Then use Brightness Correct. to match the darker projector to the lighter one. Press Enter to see the effects of your adjustments.

5. Next, adjust the brightness of Level 5 for the same two projectors. Match the brighter projector to the darker one.

6. Adjust and match the brightness of Levels 2, 3, and 4.

7. Adjust and match the G/R color correction for all levels. Then adjust and match the B/Y correction for all levels.

8. If you are using three or more projectors, repeat steps 4 through 7 to match projector 3 to projector 2, then match projector 4 to projector 3, and so on.

Note
If you use two or more projectors side-by-side, exhaust from adjacent projectors might cause overheating. Leave at least 2 feet (60 cm) of space between projectors.
The software included with your projector lets you monitor and control your projectors from a remote computer:

- Use EMP Monitor (available for Windows only) to see your projectors’ status, switch image sources, and control basic settings.
- Use the mail notification function to receive e-mail alerts about possible problems.

You can also use NS Connection to register up to 16 projectors as a group. This allows you to provide quick and easy access to these projectors from other computers.

To use the software to manage your projectors, first install EMP Monitor as described on page 182. If you plan to create projector groups, also install EMP NS Connection. Then connect and configure each projector you want to monitor. You can connect the projector wirelessly in Access Point mode (see page 65) or over a wired network as described here.

This chapter covers the following information:

- Connecting your projector to a wired network
- Monitoring and controlling your projector with EMP Monitor
- Using e-mail alerts to warn you of problems
- Using a browser to monitor the projector
Connecting to a Wired Network

Follow these steps to connect the projector to your network and configure it with an IP address.

1. Connect the projector to your network using a commercially available 100BaseTX or 10BaseT network cable. Connect the cable to the LAN port on the projector. See page 53.

2. Point the remote control at the projector and press the Power button.

3. Press the EasyMP button on the remote control to select EasyMP as the source.

4. Press the Menu button on the remote control, select the Network menu, then press Enter.

5. Choose To Network Configuration and press Enter.


You see the following screen:

7. Do one of the following:
   - If your network assigns addresses automatically, turn on the DHCP setting.
If your network does not assign addresses automatically, turn off DHCP and enter the projector’s IP Address, Subnet Mask, Gateway Address, and DNS Servers, as needed.

To enter numbers, use the £ pointer button on the remote control to highlight the number you want to input, then press the Enter button.

8. When you’re done making all necessary changes, select Return, select Setup complete, and then select Yes to confirm that you want to save the changes. Press Menu to exit the menu system.

**Using Projector E-mail Alerts**

When this feature is enabled, the projector sends you an e-mail alert if it has any problems.

1. Press the Menu button on the remote control, select the Network menu, then press Enter.
2. Choose To Network Configuration and press Enter.
3. Choose Mail, then press Enter.

You see the following screen:

---

**note**

If you’re a network administrator, you can use the SNMP option to enter a trap IP address. This lets you receive trap alerts for the projectors you’re monitoring.

**note**

You can also set e-mail alerts from EMP Monitor (see page 147).
4. Highlight On to receive email notifications, then press Enter.

5. Enter the IP address for the SMTP server for the projector.

You can enter a number from 0 to 255 in each field of the address. However, the following IP addresses cannot be used: 127.x.x.x, 224.0.0.0 to 255.255.255.255 (where x is a number from 0 to 255).

6. Enter the SMTP server’s port number. The default value is 25. You can enter a numeric value from 1 to 65535.

7. Choose one of the Destination Address fields, then enter the e-mail address where you want to receive a message when a problem occurs. You can register up to three addresses. You can enter up to 32 alphanumeric characters for the e-mail address.

8. Select problems or warnings to be notified about by mail.

(Numbers 1 through 3 in this section correspond to the e-mail addresses you entered.)

9. When you’re done making all necessary changes, select Return, select Setup complete, and then select Yes to confirm that you want to save the changes. Press Menu to exit the menu system.

When the selected problem or warning occurs, an e-mail message is sent to the specified notification addresses. The subject line of the e-mail is EPSON Projector. The e-mail includes the following information:

- Line 1: The name of the projector where the problem has occurred
- Line 2: The IP address of the projector where the problem has occurred
- Line 3: Details of the problem

---

**note**

If a critical problem develops with a projector which causes it to suddenly stop working, it may not be possible for the projector to send a message.

If Standby Mode is set to Network On in the Extended menu, the projector can still be monitored even if the projector is in standby mode (when the power is off).
**Using EMP Monitor**

EMP Monitor lets you use a remote computer to manage your projectors, whether connected wirelessly or over a wired network. It lets you easily turn the projectors on or off (together or individually), switch image sources, and check their status.

Before using EMP Monitor, make sure you’ve installed the software (available for Windows only) as described on page 182. The computer you’re using to monitor the projector should already be connected to your network.

**Opening and Closing EMP Monitor**

To start EMP Monitor, click Start > Programs or All Programs > EPSON Projector > EMP Monitor.

If you’ve added the program to the Startup programs folder, then it may already be open. If so, click the icon in the system tray on the lower-right corner of your screen to display the EMP Monitor window:

![EMP Monitor icon](image)

Click here to start EMP Monitor

To close EMP Monitor, select Exit from the File menu or right-click the program icon shown above, then select Exit.

---

**note**

If you want to monitor projectors while they are in standby mode, select Standby Mode in the Extended menu, then select Network On. See page 133.
Registering a Projector

Before you can monitor a projector, you have to register it. Follow these steps to automatically search for your projector(s).

1. Open EMP Monitor as described above. You see this screen:

   ![Screen 1](image1.png)

2. Select Edit > New > Projector (automatic search).
   
   You see this screen:

   ![Screen 2](image2.png)
3. Click **Search** to locate projectors currently operating on the network.

Any projectors found on the network are listed as shown below:

```
<table>
<thead>
<tr>
<th>Projector name</th>
<th>IP address</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP204322</td>
<td>192.168.1.104</td>
</tr>
<tr>
<td>EMP204323</td>
<td>192.168.1.105</td>
</tr>
<tr>
<td>EMP204324</td>
<td>192.168.1.106</td>
</tr>
</tbody>
</table>
```

4. Select the projector you want to add by clicking its name, then click the **Edit** button.

You see this screen:

```
Manage new projector (automatic registration)

Display name:

Display image:

Event group: [Private]

Projector name: EMP204322

IP address: 192.168.1.104

[Register] [Register] [Cancel]
```

**note**
If the projector is not automatically found, your projector may not be connected or configured correctly for the network. See page 58.
5. Enter a Display name, select a Parent group, if necessary, enter a Monitor Password, if necessary, and a Description for the projector. Then click the Register button.

To register additional projectors with EMP Monitor, repeat steps 2 through 5.

6. When you’re done adding projectors, click Cancel.

You see a screen with a list of all registered projectors:

**Monitoring Your Projectors**

The EMP Monitor screen lets you monitor your projectors using the Status, Video Source, and Error icons shown below. This lets you see which projectors are currently being used, from which source (or port) they are projecting an image, and if a problem occurs.

For detailed status information, right-click the projector in question and click Property.

**note**

To delete a projector from the list, right-click the projector name, and click Delete.

**note**

To monitor a projector when it’s in standby mode (plugged in but not turned on), you must select Network On as the Standby Mode setting in the projector’s Extended menu (see page 133).
The following tables describe the status icons shown on the EMP Monitor screen.

**Group status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>No warnings or problems. All projectors in the group are operating normally.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Warning or problem. A projector in the group has a warning or problem.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Monitoring disabled. Right click the icon and select Monitoring Enabled to begin monitoring the group.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Data is currently being updated.</td>
</tr>
</tbody>
</table>

**Type status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>No warnings or problems.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Warning or problem.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Monitor Password error. No monitor password was entered when the projector was registered, or an incorrect password was entered.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Monitoring disabled. Right-click the icon and select Monitoring Enabled to begin monitoring the projector.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Data is currently being updated.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Network error (for example, the projector is not connected to the network, or power cable is disconnected). You may also see this error if Network Off is selected in Standby Mode.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Network error (Esc/VP.net communication error).</td>
</tr>
</tbody>
</table>
### Power status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀</td>
<td>The projector is powered on and its status is normal.</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector is powered off and its status is normal.</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector is powered on and its status is abnormal.</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector is powered off and its status is abnormal.</td>
</tr>
</tbody>
</table>

### Temperature level status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀</td>
<td>The projector’s internal temperature is normal (low).</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector’s internal temperature is normal (medium).</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector’s internal temperature is normal (high).</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector’s internal temperature is high (high-temperature warning).</td>
</tr>
<tr>
<td>🍀</td>
<td>The projector’s internal temperature is too high (internal temperature error). The projector is turned off automatically.</td>
</tr>
</tbody>
</table>

### Error status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀</td>
<td>Lamp life warning. The lamp is nearing the end of its life.</td>
</tr>
<tr>
<td>🍀</td>
<td>High-temperature warning. The projector is getting too hot but continues to operate.</td>
</tr>
<tr>
<td>🍀</td>
<td>Replace air filter.</td>
</tr>
<tr>
<td>🍀</td>
<td>No air filter. The air filter is not installed or installed incorrectly.</td>
</tr>
<tr>
<td>🍀</td>
<td>Low air flow. The air filter needs to be cleaned or replaced.</td>
</tr>
</tbody>
</table>
### Error status icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Air flow sensor error. There is a problem with the projector’s air flow sensor; contact Epson as described on page 178.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Lamp cover door open. Close the lamp cover door.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Lamp out. The lamp has reached the end of its life.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Lamp failure at power on. The lamp has reached its end of life or is installed incorrectly.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>High internal temperature error. The projector is turned off automatically.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Internal (system) error. Contact Epson as described on page 178.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Fan error. Contact Epson as described on page 178.</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Sensor error. Contact Epson as described on page 178.</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Other error. Contact Epson as described on page 178.</td>
</tr>
</tbody>
</table>

See page 163 for recommended solutions to problems.
Controlling Your Projectors

The control buttons in the upper-right let you turn the projector on and off and select video sources. (Hold the mouse pointer over a button to see a description of its meaning.) Make sure you’ve selected the projector you want to operate (with the mouse pointer) before clicking one of the buttons.

*note*

To turn on a projector when it’s in standby mode (plugged in but not projecting), you must have selected **Network On** as the **Standby Mode** setting in the projector’s menu system (see page 133).
**Configuring the Monitoring Interval**

If you need to have the most current status information about your projectors, click the Refresh button in EMP Monitor.

To select how often EMP Monitor checks the status of projectors, follow the steps below:

1. From the Tool menu, select Environment Setup. You see this screen.

![Environment Setup Screen]

2. Enter the desired Update interval and click OK.

**Using E-mail Alerts**

You can set up e-mail alerts to warn you of problems with the projector. Follow the steps below:

1. Open EMP Monitor.
2. From the Tool menu, select Mail notification function.

**note**
If you want EMP Monitor to run whenever you start your computer, click Register at startup.

**note**
You can also set e-mail alerts from the projector's menu system (see page 137).
You see this screen:

![Set mail notification function window](image)

3. Turn the Mail notification function setting On.
4. Enter the IP address and port number of your network’s SMTP (outgoing) mail server.
5. Enter the Sender (projector) mail address.
6. Enter up to three e-mail addresses to send alerts to in the Recipient mail address boxes.
7. Click the Notification event buttons to select the conditions under which an e-mail alert will be sent.
8. When you’re done, click the OK button to close the Set mail notification function window.

**Understanding the Notification Messages**

If a projector experiences a problem, EMP Monitor sends an e-mail message to each of the addresses you entered in the Set mail notification function window.

The subject line of the message includes the projector’s display name, shown in EMP Monitor, and the warning/error.

The body of the message contains:
- The projector’s display name in EMP Monitor
- The error/warning message

The problem descriptions are similar to the errors listed on page 144.
When the problem has been fixed, EMP Monitor sends a message indicating the problem has been resolved.

**Using a Browser to Monitor the Projector**

If your projector is connected to a network, you can use a standard web browser to monitor and control it.

1. Make sure that the projector is set up for your network, as described on page 58. (Standby Mode in the Extended menu should be set to **Network On** to monitor the projector in standby mode.) When using a browser to access the projector, you cannot connect through a proxy server.

2. Open your web browser and enter the IP address of the projector you want to monitor in the browser window.

   If you’re not sure what the address of the projector is, turn the projector on and select **Wired LAN** or **Wireless LAN** from the Network menu to display the IP address of the projector.

   You see a login screen.

3. Do one of the following:

   - If you didn’t set a Web control password in the projector’s Network menu, click **OK**.
If you set a Web control password in the projector’s Network menu, enter it in the Password box, then click OK.

You see this screen:

4. Select one of the menu options listed on the left, then change any of the settings as needed. These settings correspond to those found in the projector’s menu system.

You cannot change the following settings using a web browser:

- **Pointer** in the Settings menu
- **User’s Logo, High Altitude Mode, and Language** in the Extended menu
- **Reset All and Reset Lamp Hours** in the Reset menu

Use the controls at the bottom of the screen just as you would the corresponding remote control buttons. Choose a source, stop the action, turn off the picture and sound, or turn the projector’s power on or off.
Transferring Files by FTP

If your projector is connected to a network as described on page 136, you can send files over the network to a CompactFlash card inserted in the projector (see page 51). Then you can use the projector’s PC Free feature to present images and movies (see page 100).

You can use any FTP client software to send files to the projector. For example, you can connect to the projector using the Finder on a Macintosh.

If you’re using a computer running Windows, follow these steps:

1. Open Windows Explorer.
2. Enter the IP address of the projector in the Address field as an FTP address (for example, ftp://192.168.100.100).
   
   You see the contents of the projector’s CompactFlash card displayed on the right:

3. Copy your files to the projector.

---

**note**

To send files to a projector when it’s in standby mode (plugged in but not turned on), you must select Network On as the Standby Mode setting in the projector’s Extended menu (see page 133).
Your projector needs little maintenance. All you have to do is keep the lens clean. You may also need to clean the air filter and vent. A clogged air filter or vent can block ventilation needed to cool the projector.

The only parts you should replace are the lamp and air filter. If any other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

- Cleaning the lens
- Cleaning the projector case
- Cleaning the air filter and vent
- Replacing the lamp and air filter
- Replacing the remote control batteries
- Transporting the projector
Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface.

Use a canister of compressed air to remove dust.

To remove dirt or smears on the lens, use lens-cleaning tissue. If necessary, moisten a soft cloth with lens cleaner and gently wipe the lens.

Cleaning the Projector Case

Before you clean the case, turn off the projector and unplug the power cord.

- To remove dirt or dust, wipe the case with a soft, dry, lint-free cloth.
- To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent. Then wipe the case.

caution

Do not use wax, alcohol, benzene, paint thinner, or other chemical detergents. These can damage the case.
Cleaning the Air Filter and Vent

Your projector includes an air filter to ensure the best performance. If dust collects on the air filter (on the bottom of the projector) or vent (on the front of the projector), clean them as described below. Dust clogs prevent proper ventilation and can cause overheating and damage the projector.

Follow these steps:

1. Turn off the projector and unplug the power cord.

2. To clean the intake vent and filter, use a small vacuum cleaner designed for computers and other office equipment. If you don’t have one, gently clean the vent with a soft brush (such as an artist’s paintbrush).

   You can remove the air filter to clean both sides (see page 158).

3. If the dirt is difficult to remove or the filter is broken, replace the filter as described on page 158. Contact your dealer or call Epson at 800-GO-EPSON (800-463-7766) to obtain a new filter.
Replacing the Lamp and Air Filter

The life span of the projection lamp is about 2500 hours if Brightness Control in the Settings menu is set to High (default), and 3000 hours if Brightness Control is set to Low. See page 159 to check the lamp usage.

It is time to replace the lamp when:

- The projected image gets darker or starts to deteriorate.
- The message Replace the lamp appears on the screen when the lamp comes on and the lamp warning light \( \text{熄} \) flashes orange. To maintain projector brightness and image quality, replace the lamp as soon as possible.
- The lamp warning light \( \text{熄} \) flashes red (the lamp is burnt out).

Contact your dealer or call Epson at 800-GO-EPSON (800-463-7766). Request part number V13H010L40.

note
When you get a replacement lamp for your projector, you should replace the filter.

Turn off this product when not in use to prolong the life of the projector.
Follow these steps to replace the lamp and air filter:

1. Turn off the projector and unplug the power cord.
2. Let the projector cool for at least an hour (if it has been on). The lamp is extremely hot immediately after use.
3. Loosen the lamp cover screw (you don’t need to remove it). Then slide the lamp cover to the side and lift it off of the projector.

**warning**

Let the lamp cool fully before replacing it.

In the unlikely event that the lamp has broken, small glass fragments may be present and should be removed carefully to avoid injury.

If the lamp is used after the replacement period has passed, the possibility that the lamp may break increases. When a lamp replacement message appears, replace the lamp with a new one as soon as possible, even if it is still working.

4. Loosen the two screws holding the lamp in place (you can’t remove them).
5. Hold the lamp as shown and pull it straight out.

6. Gently insert the new lamp. (If it doesn’t fit easily, make sure it is facing the right way.)

7. Once the lamp is fully inserted, tighten its screws.

8. Replace the lamp cover, then tighten its screw.

9. Slide out the air filter on the bottom of the projector and remove it.

10. Slide in the new air filter until it clicks in place.

11. Reset the lamp timer as described in the next section.

**note**

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.
**Resetting the Lamp Timer**

After you replace the lamp, you need to reset the lamp timer using the projector’s menus.

1. Press the **Menu** button on the remote control or on the projector’s control panel. You see the main menu.

2. Use the ☰ pointer button on the remote control (or the arrow buttons on the projector) to highlight Reset, then press **Enter**. You see this screen:

![Reset menu](image)

3. Select **Reset Lamp Hours** and press **Enter**.

4. When you see the prompt, select **Yes** and press **Enter**.

5. When you’re finished, press **Menu** to exit the menu system.

**Checking Lamp Usage**

To check the number of hours the lamp has been used, press the **Menu** button and highlight the **Info** menu. You see a screen like this:

![Info menu](image)

**note**

The information displayed depends on the input signal currently selected.
The life span of the lamp is about 2500 hours if the Brightness Control setting in the Settings menu is set to High (default), and 3000 hours if the Brightness Control setting is set to Low. Make sure you have a spare lamp handy if the usage hours on this menu are close to the life span of your lamp.

**Replacing the Batteries**

Replace the batteries in the remote control as described below:

1. Turn the remote control over.
2. Press down on the tab on the battery cover as you lift the cover off.
3. Install two AAA batteries, inserting the + and – ends as shown.
4. Position the cover as shown, then press down until it snaps into place.

---

**caution**

When replacing batteries, take the following precautions:

- Replace the batteries as soon as they run out. If the batteries leak, wipe away battery fluid with a soft cloth. If fluid gets on your hands, wash immediately.
- Do not expose batteries to heat or flame.
- Dispose of used batteries according to local regulations.
- Remove the batteries if you won’t be using the projector for a long period of time.
Transporting the Projector

The projector contains many glass and precision parts. Follow these guidelines to prevent damage:

- When shipping the projector for repairs, use the original packaging material if possible. If you do not have the original packaging, use equivalent materials, placing plenty of cushioning around the projector.

- When transporting the projector a long distance, first place it in a hard-shell shipping case, then pack it in a firm box with cushioning around the case.

- Close the A/V mute slide (lens cover) to protect the lens.

- If a CompactFlash card is installed, remove it from the projector. Make sure the card eject button is pushed all the way in, or it could be damaged.

*note*
Epson shall not be liable for any damages incurred during transportation.
Solving Problems

This chapter helps you solve problems with your projector, and tells you how to contact technical support for problems you can’t solve yourself. The following information is included:

- Using the projector’s on-screen help system
- What to do when the projector’s status lights flash
- Solving projector operation problems
- Solving problems with the image or sound
- Solving network problems
- Solving EasyMP problems
- Solving problems with the remote control
- Contacting technical support
Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can get help by pressing the ? Help button on top of the projector or on the remote control.

1. Press the ? Help button on the remote control or on the projector.

You see the Help menu:

2. Use the pointer button on the remote control or the navigational buttons on the projector to highlight menu items.

3. Press the Enter button on the remote control or on the projector to select the menu item.

4. To exit the help system, press the ? Help button.

If none of the suggestions solve your problem, see additional solutions to problems in the following sections.
Checking Projector Status

If your projector isn’t working correctly, first turn it off, wait for it to cool (the Power light stops flashing orange), and unplug it. Then plug the power cord back in and turn on the projector. If this doesn’t solve the problem, check the lights on top of the projector.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status.

Refer to the following table for a complete description of the projector’s status lights:

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☺</td>
<td>Orange</td>
<td>The projector is in sleep or standby mode. You can unplug it or press the ☺ Power button to turn it on.</td>
</tr>
<tr>
<td>☺</td>
<td>Flashing green</td>
<td>The projector is warming up. Wait for the image to appear.</td>
</tr>
<tr>
<td>☺</td>
<td>Green</td>
<td>The projector is operating normally.</td>
</tr>
<tr>
<td>☺</td>
<td>Flashing orange</td>
<td>The projector is cooling down. You can’t turn it back on until the light stops flashing and remains orange.</td>
</tr>
<tr>
<td>☺</td>
<td>Red</td>
<td>There is a problem with the projector. Check the other two lights and the information on page 166 to diagnose the problem.</td>
</tr>
</tbody>
</table>
Solving Problems

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Flash Light]</td>
<td>Orange</td>
<td>Rapid cooling is in progress. Although this is not an abnormal condition, projection will stop automatically if the temperature rises higher. Make sure there is plenty of space around and under the projector for ventilation, and that the air filter and vents are clear.</td>
</tr>
<tr>
<td>![Flash Light]</td>
<td>Red</td>
<td>The projector is overheating, which turns the lamp off automatically. Wait until the cooling fan stops, then unplug the power cord. Plug the power cord back in and press the <strong>Power</strong> button. Make sure the room temperature is not above 95 °F (35 °C), and there is plenty of space around and under the projector for ventilation. If you’re using the projector above an altitude of 5000 feet (1500 m), turn on <strong>High Altitude Mode</strong> in the Operation menu (see page 132). The air filter or vents may be clogged. Clean them or replace the air filter as described on pages 155 to 158. If the projector continues to overheat after you clean the air filter, the problem may be caused by damage to the cooling fan or temperature sensor. Contact Epson for help as described on page 178. <strong>Warning:</strong> Except as specifically explained in this <em>User’s Guide</em>, do not attempt to service this product yourself.</td>
</tr>
<tr>
<td>![Flash Light]</td>
<td>Red</td>
<td>There is a problem with the fan or temperature sensor. The air filter or vents may be clogged. Clean them or replace the air filter as described on pages 155 to 158. If this does not resolve the problem, stop using the projector, disconnect the power cable, and contact Epson as described on page 178.</td>
</tr>
<tr>
<td>![Flash Light]</td>
<td>Orange</td>
<td>It’s time to replace the lamp. See page 156 for instructions. If you continue to use the lamp after the replacement warning, there is an increased possibility that the lamp may break.</td>
</tr>
<tr>
<td>![Flash Light]</td>
<td>Red</td>
<td>The lamp may be burnt out. First make sure the lamp cover is securely installed. If that’s not the problem, let the lamp cool, remove the lamp, and replace it as described on page 156. The air filter or vents may be clogged. Clean them or replace the air filter as described on pages 155 to 158. If this does not resolve the problem, contact Epson as described on page 178.</td>
</tr>
<tr>
<td>![Flash Light]</td>
<td>Red</td>
<td>Power is cut off because of an internal problem. Unplug the power cord and contact Epson for help, as described on page 178.</td>
</tr>
</tbody>
</table>
Solving Projector Operation Problems

The power doesn’t turn on.
- If the projector doesn’t turn on when you press the Power button, make sure the power cable is connected to the projector and plugged into a working electrical outlet.
- The power cable may be defective. Disconnect the cable from the outlet and contact Epson as described on page 178.
- Check to see if the A/V mute slide (lens cover) is closed.

The buttons on the projector don’t work.
If the Operation Lock function has been enabled, you can’t use the buttons on the projector. Try using the remote control instead. See page 131 for information about the Operation Lock function.

Solving Problems with the Image or Sound

No image appears on the screen.
- Check that the Power light is green, not flashing.
- The projector may be in standby or sleep mode. If the Power light is orange, press the Power button to turn the projector on.
- If the power was switched off and then on again, the projector may be cooling down. Wait until the Power light stops flashing and remains orange; then press the Power button again.
- Press the A/V Mute button on the remote control to make sure the picture has not been turned off temporarily.
- Open the A/V mute slide (lens cover), if it is closed.
- The attached computer may be in sleep mode or displaying a black screen saver. Try pressing a key on the computer.
■ If you are projecting from a DVD player or other video source, make sure you turn it on and press its Play button.

You’ve connected a computer and see a blue screen with the message No Signal displayed.

■ Make sure the cables are connected correctly, as described on page 38.

■ If you’ve connected a computer and one or more video sources, you may need to press the Source Search button on the projector or one of the source buttons on the remote control to select the correct source. Allow a few seconds for the projector to sync up after pressing the button.

If you’re using a PC notebook:

■ Hold down the Fn key on the keyboard and press the function key that lets you display on an external monitor. It may have an icon such as CRT/LCD, or it may be labelled CRT/LCD. Allow a few seconds for the projector to sync up after pressing it. Check your notebook’s manual or online help for details.

   On most systems, the CRT/LCD key lets you toggle between the LCD screen and the projector, or display on both at the same time.

■ Depending on your computer’s video card, you might need to use the Display utility in the Control Panel to make sure that both the LCD screen and external monitor port are enabled. See your computer’s documentation or online help for details.

If you’re using Mac OS X:

1. Open System Preferences.
2. Click Displays.
3. Click Detect Displays.
4. Make sure the VGA Display or Color LCD dialog box is selected.
5. Click the Arrangement or Arrange tab.
6. Make sure the Mirror Displays checkbox is selected.
The message Not Supported is displayed.

- Make sure the correct input signal is selected in the Signal menu (see page 124).
- Make sure your computer’s resolution doesn’t exceed UXGA (1600 × 1200) and the frequency or refresh rate is supported by the projector (see page 189). If necessary, change your computer’s resolution setting.

Only part of the computer image is displayed.

- Press the Auto button on the remote control.
- Make sure the image Position setting is correct in the Signal menu. See page 125 for more information.
- Press the Resize button on the remote control.
- Press the Esc button on the remote control to cancel the E-Zoom function.
- Make sure your computer’s resolution setting is correct. Ideally, it should be 1024 × 768 to match the projector’s native resolution. If this option isn’t available, select one of the other compatible video formats listed on page 189.
- You also may need to modify existing presentation files if you created them for a different resolution. See your software documentation for specific information.

The image isn’t square, but keystone-shaped.

- If the image isn’t square or rectangular, adjust its shape as described on page 24.
- Enable the Auto Keystone feature to automatically fix the shape when the projector is tilted upward. See page 126.
The image contains static or noise.

- If you’re using a computer cable longer than 6 feet, or an extension cable, the image quality may be reduced.
- Keep your computer and video cables away from the power cord as much as possible to prevent interference.
- The video signal may be split between the computer and the projector. If you notice a decline in the projected image quality when the image is displayed simultaneously on your notebook computer and the projector, turn off the notebook’s LCD display.
- Make sure the correct input signal is selected in the Signal menu (see page 125).
- If you’ve used the Quick Setup, Quick Corner, or Keystone adjustment, you may need to decrease the Sharpness setting in the Image menu (see page 123).

The image is blurry.

- There may be dirt or smears on the lens. Clean the lens as described on page 154.
- Adjust the focus using the focus ring (see page 24).
- If the projector is angled sharply toward the screen, it may not be possible to focus the entire image. Move the projector to position it more directly in front of the screen.
- Make sure the projector is within the proper range (projection distance) from the screen (see page 187).
- Make sure the lens is not fogged by condensation. You may need to wait before using the projector after moving it from a cold environment to a warm environment.
- If you’re projecting from a computer, you may need to adjust the tracking and sync as described in the next section.
You see vertical bands or the image still looks blurry after trying the solutions in the previous section.

- If you’re projecting from a computer and displaying an image that contains a lot of fine detail, you may notice vertical bands or some of the characters may look heavy or blurred. Press the Auto button on the remote control or the Enter button on the projector to reset the projector’s Tracking, Sync, and Position settings.

- If further adjustment is needed, you can fine-tune the Tracking and Sync settings manually using the Signal menu, as described on page 125.

1. Fill the screen with an image containing fine detail, such as a pattern to appear as your desktop background, or try projecting black text on a white background.

2. Adjust the Tracking to eliminate vertical bands.

3. Adjust the Sync setting to increase the image sharpness.

The image is too light or dark, or colors are incorrect.

- Use the Color Mode option in the projector’s Image menu to adjust the color (see page 122).

- If you’re displaying video, adjust the Color Adjustment and Color Mode settings on the Image menu. You can also try adjusting the Color Saturation, ABS Color Temp, and Tint settings on the Image menu.

---

**note**

You must be projecting an image for this button to have any effect. The Auto button works only with computer images projected through the VGA port.

**note**

Because of the different technologies used, your projected image may not exactly match the colors on your notebook or computer monitor.
■ Try adjusting the Brightness and Contrast settings on the Image menu.

■ Check your computer display settings to correct the color balance.

■ The projector’s lamp may need to be replaced. See page 156 for instructions.

■ Make sure the correct input signal is selected in the Signal menu (see page 125).

There is no sound, or the sound is not loud enough.

■ Use the Volume buttons on the remote control to adjust the volume, or adjust the Volume setting in the Settings menu (see page 126).

■ Make sure A/V Mute is not enabled. (The A/V Mute button may have been pressed.)

■ Make sure the A/V mute slide (lens cover) is open.

■ If your presentation includes computer audio, make sure the volume control on your computer is not turned all the way down or muted. In Windows, you may be able to check this by clicking the volume control in your Windows system tray (lower right corner of the screen). On a Mac, you may be able to adjust the volume from your menu bar (top right corner of the screen) or via the volume control function keys.

■ If you’re using a DVD player or other video source, make sure the cables are connected correctly, as described on page 48.

■ If you’re using a computer audio cable, make sure it is connected to your computer’s headphones jack or audio output jack. Connect the other end to the projector’s Audio1 port when the computer’s video cable is connected to the Computer1 port. Otherwise, connect the cable to Audio2 if you’re using Computer2 for the computer’s video connection.
Solving Network Problems

You don’t see your projector in the EMP Monitor window.

- Make sure that you’ve connected the projector to the network and configured it correctly; see page 58. Also, make sure you’ve registered the projector with EMP Monitor; see page 139.
- Make sure that Standby Mode in the projector’s Extended menu is set to Network On.
- If the computer you are using is running Windows XP or 2000, you must be logged in as the Administrator.
- Try restarting your computer.

You can’t connect to the projector using NS Connection.

- Make sure the wireless network module is installed correctly in the projector; see page 52. If you have to reinstall the module, restart NS Connection or the program will not be able to detect the projector.
- Restart your computer.
- Make sure your projector and computer are configured correctly; see page 59 (Ad Hoc mode) or page 65 (Access Point mode).
- Make sure that you have sufficient wireless signal strength (above 50 percent). On a Mac, check the AirPort icon on the Mac menu bar. In Windows, see the documentation for your computer’s wireless card or adapter for details.
- Make sure you aren’t projecting one of the EasyMP configuration screens. (You should see a message that the projector is ready to connect.) If you have to exit a configuration screen, restart NS Connection.
- If the projector is configured for Access Point mode and you’re using DHCP, allow time for your projector to appear. It takes the server a little while to pick up the IP address.
- If you’ve changed any settings for your projector or network, or restarted your computer, allow a minute or two for the connection to appear. If you’re using AirPort, try turning AirPort off and then on again.

- Make sure that you’re trying to connect to the right network. In Windows, verify that you’ve enabled your computer’s connection to the access point (see page 71) or that your wireless card or adapter is enabled and its SSID is set to match the projector’s ESSID (see page 63). On a Mac, click the AirPort icon at the top of your Mac desktop to make sure AirPort is turned on and the projector’s ESSID or your AirPort network is selected.

- If you have an access point or AirPort base station and you’re not using DHCP, check your projector’s IP address on the Access Point mode advanced settings screen. The first three segments of the IP address should be identical to the first three segments of the IP address of your access point or base station. The last segment of the projector’s IP address should be close, but not identical, to the last segment of the IP address of the access point or base station.

- If you’re not using DHCP, check your projector’s Gateway address on the projector’s Access Point mode advanced settings screen. It should be identical to the IP address for your access point or AirPort base station.

- If you’re using a projector keyword, it changes each time you turn the projector off and then on again, or remove and reinsert the wireless network module. Check the projector’s keyword on the EasyMP Network screen and enter it at the prompt.

- If you’re using AirPort, check the configuration of your network. Start the AirPort Admin utility, select your base station, click **Configure** and click **Show All Settings**. Click the **Network** tab. If you set up your projector to connect in DHCP mode, turn on **Distribute IP Addresses** and **Share a Single IP Address**.

- If you’re using AirPort and DHCP is turned off on your projector’s Access Point mode advanced settings screen, make sure **Distribute IP Addresses** is off.
If you’re using Access Point mode and you’re connecting to the wrong network, you may be experiencing signal interference from another network. Try resetting your access point or base station, then restart NS Connection.

If you’re using AirPort, the projector’s ESSID should match the AirPort network name, not the name of the AirPort base station. To check the network name, start the AirPort Admin utility, select your base station, and click Configure. Then click Show All Settings. The network name appears on the AirPort tab.

If you’re prompted for a password when you connect, enter the WEP encryption key (if you’re using WEP encryption).

Try connecting using IP Connect Mode; see page 86.

### Solving EasyMP Problems

**An image displayed with EasyMP appears distorted.**

Some high-resolution images cannot be displayed correctly. Files with a high compression ratio may appear blurry. For BMP, GIF, and PNG files, make sure the resolution is not greater than 1024 x 768. For JPG files, the resolution must not be greater than 8192 x 6144, and the image cannot be in progressive and CMYK color format.

**In EMP SlideMaker, PowerPoint files don’t appear in the file window.**

EMP SlideMaker does not support PowerPoint 95 or 97. Files created in these versions of PowerPoint must be opened and resaved in PowerPoint 2000 or later.

**In EMP SlideMaker, your PowerPoint files don’t display thumbnails and can’t be pasted into scenarios.**

Make sure the MS Office JPEG converter has been installed. See the MS Office documentation for instructions. Also, make sure PowerPoint is installed on the computer you’re using to build the scenario.
You can’t edit scenario files in EMP SlideMaker after they have been transferred to the USB drive.

You can only edit scenarios before they are transferred. Open the scenario files saved on your hard drive, make any changes, then transfer the scenario to your USB drive.

You can’t transfer your slideshow to the drive because you aren’t able to see the drive letter.

You must connect the drive to your computer before you select Send Scenario from the Scenario Option(s) menu. If this happens, close and restart EMP SlideMaker 2. Make sure your drive is connected before you select Send Scenario.

You can’t play your movies on the projector.

- The projector only supports MPEG2 files. It does not support MPEG1 files. The audio format is MPEG1 Layer 2. Linear PCM and AC-3 audio cannot be played back.
- If your MPEG2 movie stops playing, check the light on the projector’s wireless module. If the light doesn’t come on, turn off the projector and reinstall the module.
- Movie files included in a PowerPoint presentation can’t be played back in a scenario.

EasyMP is unable to see the image files on your camera or external drive.

Make sure your camera or drive shows up on your desktop as a drive letter when you connect it to your computer. If it does, it is probably a USB-mounted device and will work with your projector. The projector does not support TWAIN-compliant digital cameras.
When using EasyMP, you see an ERR code at the bottom of the screen.

Check for the code below.

<table>
<thead>
<tr>
<th>ERR Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 50, 53, 245, or -103</td>
<td>Failed to start EasyMP. Turn the projector off, then turn it back on again.</td>
</tr>
<tr>
<td>51, 52, or 100</td>
<td>EasyMP processing error. If you’re using EMP NS Connection, try reconnecting to the projector. If you’re projecting through the projector’s USB port, reconnect the USB cable.</td>
</tr>
<tr>
<td>-101</td>
<td>Communication was cut off. Check the access point connection (see page 65).</td>
</tr>
<tr>
<td>-102 or -105</td>
<td>Unstable wireless communication. Network traffic may be high. Wait for a while, then try reconnecting.</td>
</tr>
</tbody>
</table>

**Solving Problems with the Remote Control**

**The projector doesn’t respond to remote control commands.**

- The remote control’s batteries may not be installed correctly or may be low on power. To change the batteries, see page 160.
- Make sure you are within about 20 feet (6 meters) of the projector and within range of the projector’s front or back sensor (approximately 30° to the left or right and 15° above or below).
- Dim the room lights and turn off any fluorescent lights. Make sure the projector is not in direct sunlight. Strong lighting, especially fluorescent lights, may affect the projector’s infrared receivers. Also, turn off any nearby equipment that emits infrared energy, such as a radiant room heater. If necessary, use the **Remote Receiver** setting to disable the projector’s front or back sensor if it continues to pick up interference (see page 127).
■ Make sure the Remote Receiver setting isn’t disabling both of the projector’s sensors (see page 127).

■ If any buttons are held for longer than 30 seconds, the remote enters sleep mode. Release any button that is held to wake the remote.

Where To Get Help

Epson provides these technical support services:

Internet Support

Visit Epson’s support website for solutions to common problems. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Visit Presenters Online to access tips, templates, and training for developing successful presentations.

Speak to a Support Representative

To use the Epson PrivateLine Support service, call (800) 637-7661 and enter the PIN on the included Epson PrivateLine Support card. This is the fastest way of speaking to a live representative, and it’s free. This service is available 6 AM to 6 PM, Pacific Time, Monday through Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one of these numbers:

■ U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday through Friday.

■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.
Before you call for support, please have the following information ready:

- Product name (PowerLite 1815p)
- Product serial number (located on the projector)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer or video configuration
- Description of the problem

**Purchase Supplies and Accessories**

You can purchase screens or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at [www.epsonstore.com](http://www.epsonstore.com) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales).
Software Installation

The EasyMP software CD-ROM includes the software you need to use the projector’s EasyMP features—for presenting over a wireless network, transferring PowerPoint presentations to a memory card, and monitoring the projector from a remote location. Epson Projector Software CD-ROM includes EMP Monitor and EMP Network Manager for presenting and monitoring the projector from a remote location.

Windows System Requirements

Before you install the software, make sure your computer meets these requirements:

- Microsoft Windows 2000 (SP4) or Windows XP
- 802.11g or 802.11b, or 802.11a network card or wireless adapter (to use EMP NS Connection wirelessly)
- IBM® compatible PC with at least a Pentium® III 1.2 GHz processor
- At least 256MB of RAM (512 recommended)
- At least 128MB of free hard disk space
- XGA (1024 × 768) or better display adapter and monitor, 16-bit color or higher

note
Although EMP Slidemaker and EMP Monitor work in Windows 98 and Me, EMP NS Connection requires Windows 2000 or XP.
**Mac System Requirements**

Before you install the software, make sure your Mac meets the following requirements:

- Mac OS X 10.3 or later (OS X 10.3.9 to 10.4.5 recommended)
- AirPort (802.11b) or AirPort Extreme (802.11g) wireless network interface to use EMP NS Connection wirelessly
- Power Macintosh® series G3 900 MHz or more, iMac®, PowerBook®, or iBook®
- At least 256MB of RAM
- At least 128MB of free hard disk space
- XGA (1024 × 768) or better display adapter and monitor, 16-bit color or higher

**Installing the Software on a Windows System**

Follow these steps:

1. Insert the EasyMP CD-ROM in your computer’s CD-ROM or DVD drive.
2. Click Custom, then make sure EMP Monitor is selected (along with the other two options).
3. Click **Install**, then follow the on-screen instructions to install your projector software.

4. When you see the Virtual Display screen, you can select one or more virtual displays to use for multi-screen projection (see page 90). Windows lets you use two by default, but you can select up to four more if you plan to use additional projectors.

   After you install the software, you can change your Virtual Display selection by accessing **EPSON Projector** from the Start menu and selecting **Add-Remove EPSON Virtual Display**.

   If you see a message that the Epson Projector Support Driver has not passed Windows Logo testing, click **Continue Anyway**. If you have selected multiple Virtual Displays, you will see this message several times.

5. When installation is complete, click **Exit** to close the installation window.

---

### Installing the Software on a Mac

Follow these steps to install EMP NS Connection:

1. Insert the EasyMP software CD-ROM in your drive.

2. If necessary, double-click the **Epson** CD-ROM icon to open its window.

3. Double-click the **Installer for Mac OS X** icon.

4. Click **Install**, then follow the on-screen instructions to install the software.

5. When installation is complete, click **Exit** to close the installation window.

---

**note**

*If you select more virtual displays, your computer may slow down depending on its capabilities.*
Projector Installation

This appendix provides guidelines on installing the projector in a permanent location, such as a theater or conference room.

The projector can be installed for four different viewing setups: front projection, ceiling projection, rear projection onto a semi-transparent screen, or rear/ceiling projection, as shown:

To project from overhead, you’ll need the optional ceiling mounting hardware (see page 13). You’ll also need to select the appropriate Projection setting in the projector’s Extended menu to flip the image upside-down (see page 132).

If you’re mounting the projector on the ceiling and you place it above screen level, you’ll have to tilt the projector down to position the image on the screen. This causes the image to lose its square shape. You can correct the image using the projector’s Quick Setup, Quick Corner, and/or Keystone functions, as described on page 24.
The projector includes security features to prevent its theft when installed or used in public locations:

- **Security cable attachment** You can attach a commercially available security cable as shown below to secure the projector to a table or ceiling mount.

- **Kensington security slot** The security slot is compatible with the MicroSaver security systems manufactured by Kensington. You can purchase this lock from Epson (see page 13).

In addition, the projector includes several menu-operated security features. See page 127.
**Technical Specifications**

### General

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of display</td>
<td>Epson poly-silicon TFT active matrix</td>
</tr>
<tr>
<td>Resolution (native format)</td>
<td>1024 × 768 pixels (XGA)</td>
</tr>
<tr>
<td>Color reproduction</td>
<td>16.8 million colors</td>
</tr>
<tr>
<td>Brightness (High Brightness)</td>
<td>3500 lumens</td>
</tr>
<tr>
<td>Brightness (Low Brightness)</td>
<td>2700 lumens</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>500:1</td>
</tr>
<tr>
<td>Image size</td>
<td>30 to 300 inches</td>
</tr>
<tr>
<td>Projection distance</td>
<td>2.7 to 48.2 feet (0.8 to 14.7 meters)</td>
</tr>
<tr>
<td>Projection methods</td>
<td>Front, rear, upside-down (ceiling mount)</td>
</tr>
<tr>
<td>Internal sound system</td>
<td>5 W monaural</td>
</tr>
<tr>
<td>Optical aspect ratio</td>
<td>4:3 (horizontal:vertical)</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>1:1.6</td>
</tr>
<tr>
<td>Noise level</td>
<td>32 dB in Low Brightness mode, 37 dB in High Brightness mode</td>
</tr>
<tr>
<td>Keystone correction</td>
<td>±30° vertical (automatic/manual)</td>
</tr>
<tr>
<td></td>
<td>±20° horizontal (manual)</td>
</tr>
<tr>
<td>Mouse compatibility</td>
<td>Supports USB (type B)</td>
</tr>
</tbody>
</table>
**Projection Lamp**

Type: UHE (Ultra High Efficiency)

Power consumption: 210 W

Lamp life:
- Approx. 2500 hours (High Brightness mode)
- Approx. 3000 hours (Low Brightness mode)

Part number: V13H010L40

**Remote Control**

Range: 20 feet (6 meters)

Batteries (2): Alkaline AAA

**Dimensions**

Height: 3.4 inches (86 mm), feet retracted

Width: 13.6 inches (345 mm)

Depth: 10.1 inches (257 mm)

Weight: 6.9 lb (3.1 kg)

**Electrical**

Rated frequency: 50/60 Hz AC

Power supply:
- 100 to 120 VAC, 3.4 A
- 200 to 240 VAC, 1.5 A

Power consumption:
- Operating:
  - 100 to 120 VAC, 306 W
  - 220 to 240 VAC, 286 W
- Standby:
  - 100 to 120 VAC, 2.6 W (network off)
  - 12 W (network on)
  - 220 to 240 VAC, 4.6 W (network off)
  - 12 W (network on)

*note*

Lamp life results will vary depending upon mode selected, environmental conditions, and usage.

Turn off this product when not in use to prolong the life of the projector.
**Environmental**

**Temperature**
- Operating: 41 to 95 °F (5 to 35 °C)
- Storage: 14 to 140 °F (–10 to 60 °C)

**Humidity**
- Operating: 20 to 80% RH
- Storage: 10 to 90% RH

**Operating altitude**
- 0 to 7,500 ft (0 to 2,286 m)

**Safety and Approvals**

United States
- FCC 47CFR Part 15B Class B (DoC)
- UL60950 Third Edition

Canada
- ICES-003 Class B
- CSA C22.2 No. 60950

CE Marking
- Directive 73/23/EEC
- Directive 89/336/EEC
- IEC 60950 Third Edition
- EN 55022, EN 55024

Pixelworks™ DNX™ ICs are used in this projector.

**Compatible Video Formats**

The projector supports the high definition video and computer display formats listed below, as well as traditional NTSC, PAL, and SECAM video standards.

To project images output from a computer, the computer’s video card must be set at a refresh rate (vertical frequency) that’s compatible with the projector. Some images are automatically resized using Epson’s SizeWize™ technology to display in the projector’s native format (XGA). The frequencies of some computers may not allow images to display correctly; see your computer’s documentation for details.
### Compatible video formats

<table>
<thead>
<tr>
<th>Mode</th>
<th>Refresh Rate (Hz)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA EGA</td>
<td>70</td>
<td>640 × 350</td>
</tr>
<tr>
<td>VGA—60</td>
<td>60</td>
<td>640 × 480</td>
</tr>
<tr>
<td>VESA—72</td>
<td>72</td>
<td>640 × 480</td>
</tr>
<tr>
<td>VESA—75</td>
<td>75</td>
<td>640 × 480</td>
</tr>
<tr>
<td>VESA—85</td>
<td>85</td>
<td>640 × 480</td>
</tr>
<tr>
<td>VGA—120</td>
<td>120</td>
<td>640 × 480</td>
</tr>
<tr>
<td>SVGA—56</td>
<td>56</td>
<td>800 × 600</td>
</tr>
<tr>
<td>SVGA—60</td>
<td>60</td>
<td>800 × 600</td>
</tr>
<tr>
<td>SVGA—72</td>
<td>72</td>
<td>800 × 600</td>
</tr>
<tr>
<td>SVGA—75</td>
<td>75</td>
<td>800 × 600</td>
</tr>
<tr>
<td>SVGA—85</td>
<td>85</td>
<td>800 × 600</td>
</tr>
<tr>
<td>SVGA—120</td>
<td>120</td>
<td>800 × 600</td>
</tr>
<tr>
<td>XGA—60</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—70</td>
<td>70</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—75</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—85</td>
<td>85</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—120</td>
<td>120</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SXGA1—70</td>
<td>70</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA1—75</td>
<td>75</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA1—85</td>
<td>85</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA1—120</td>
<td>120</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA2—60</td>
<td>60</td>
<td>1280 × 960</td>
</tr>
<tr>
<td>SXGA2—75</td>
<td>75</td>
<td>1280 × 960</td>
</tr>
<tr>
<td>SXGA2—85</td>
<td>85</td>
<td>1280 × 960</td>
</tr>
<tr>
<td>SXGA+60</td>
<td>60</td>
<td>1400 × 1050</td>
</tr>
<tr>
<td>SXGA+75</td>
<td>75</td>
<td>1400 × 1050</td>
</tr>
<tr>
<td>SXGA+85</td>
<td>85</td>
<td>1400 × 1050</td>
</tr>
<tr>
<td>SXGA3—60</td>
<td>60</td>
<td>1280 × 1024</td>
</tr>
<tr>
<td>SXGA3—75</td>
<td>75</td>
<td>1280 × 1024</td>
</tr>
<tr>
<td>SXGA3—85</td>
<td>85</td>
<td>1280 × 1024</td>
</tr>
<tr>
<td>UXGA—60</td>
<td>60</td>
<td>1600 × 1200</td>
</tr>
<tr>
<td>iMAC VGA</td>
<td>117</td>
<td>640 × 480</td>
</tr>
<tr>
<td>iMAC SVGA</td>
<td>95</td>
<td>800 × 600</td>
</tr>
<tr>
<td>iMAC XGA</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC13</td>
<td>67</td>
<td>640 × 480</td>
</tr>
<tr>
<td>MAC16</td>
<td>75</td>
<td>832 × 624</td>
</tr>
<tr>
<td>MAC19</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC19-60</td>
<td>59</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC21</td>
<td>75</td>
<td>1152 × 870</td>
</tr>
</tbody>
</table>
Compatible video formats (continued)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Refresh Rate (Hz)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>NTSC 4:3</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>N-PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>M-PAL</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL—60</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>SECAM</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>TV480i</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>TV625i</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>50</td>
<td>—</td>
</tr>
</tbody>
</table>
This appendix includes safety instructions and other important information about your projector.

**Important Safety Instructions**

Follow these safety instructions when setting up and using the projector:

- Do not look into the lens when the projector is on. The bright light can damage your eyes.
- Do not place the projector on an unstable cart, stand, or table.
- Do not operate the projector on its side, or while tilted to one side. Do not tilt the projector forward or back at a greater angle than that specified for vertical keystone correction (see page 187).
- If the projector is mounted on a ceiling, it should be installed by qualified technicians using mounting hardware designed for use with this projector.
- Do not stand on the projector or place heavy objects on it.
- Do not use the projector where it may be exposed to rain, water, or excessive humidity.
- Unplug the projector from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not use liquid or aerosol cleaners.
- Never spill liquid of any kind into the projector.
- Never spill liquid of any kind into the projector.
- Do not use the projector where it may be exposed to excessive dust or smoke.
- Never push objects of any kind through the cabinet slots.
- Do not use or store the projector or remote control in a hot location, such as near a heater, in direct sunlight, or in a closed vehicle.
- Do not block the slots and openings in the projector case. They provide ventilation and prevent the projector from overheating. Do not operate the projector on a sofa, rug, or other soft surface, or set it on top of loose papers, which could block vents underneath your projector.
Do not operate the projector in a closed-in cabinet unless proper ventilation is provided.

If you are using two or more projectors side-by-side, leave at least 2 feet (60 cm) of space between the projectors to allow for proper ventilation.

You may need to clean the air filter and vent. A clogged air filter or vent can block ventilation needed to cool the projector.

Do not use the projector outside of the required temperature range of 41 to 95 °F (5 to 35 °C). Doing so may cause an unstable display and could lead to projector damage.

Do not store the projector outside of the required temperature range of 14 to 140 °F (–10 to 60 °C) or in direct sunlight for long periods of time. Doing so may cause damage to the case.

Unplug the projector during lightning storms or when it will not be used for extended periods.

Unplug the projector from the wall outlet and refer servicing to qualified service personnel under the following conditions: If it does not operate normally when you follow the operating instructions, or exhibits a distinct change in performance. If smoke, strange odors, or strange noises come from the projector. If the power cord or plug is damaged or frayed. If liquid or foreign objects get inside the projector, or if it has been exposed to rain or water. If it has been dropped or the housing has been damaged.

Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified personnel. Opening or removing covers may expose you to dangerous voltages and other hazards.

Use the type of power source indicated on the projector. If you are not sure of the power available, consult your dealer or power company.

If you use the projector in a country other than where you purchased it, use the correct power cord for that country.

Do not overload wall outlets, extension cords, or power strips. This can cause fire or electric shock.

Take the following precautions when handling the plug: Do not hold the plug with wet hands. Do not insert the plug into an outlet with dust present. Insert the plug firmly into the outlet.

Do not place the projector where the cord can be walked on.

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.
If the lamp breaks, ventilate the room to prevent gases contained in the lamp from being inhaled or coming in contact with the eyes or mouth.

If the projector is mounted overhead and the lamp breaks, be careful to prevent pieces of glass from falling into your eyes when you open the lamp cover.

**WARNING**: The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. *Wash hands after handling.* *(Provided in accordance with Proposition 65 in Cal. Health & Safety Code §25249.5 et seq.)*

---

**FCC Compliance Statement**

**For United States Users**

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING**

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.
**For Canadian Users**

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

*Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.*
Index

A

A/V Mute
  button, 31
display settings, 131
Access Point mode, 65 to 75
Access point, checking IP address of, 72 to 73
Accessories, 13
Ad Hoc mode, 59 to 64
Air filter
  cleaning, 155
  ordering, 13
  replacing, 156 to 158
AirPort, configuring for wireless, 63 to 64,
  73 to 75
Altitude, 133, 166, 189
Anti-theft device, 13, 17, 186
Aspect ratio, 187
Audio
  connecting equipment, 48 to 49
  controlling volume, 33
  problems, troubleshooting, 172
  turning off (using A/V Mute), 31
  using with scenarios, 108
Authentication, 79 to 80
Auto Setup setting, 125
Autorun setting, 114 to 115

B

Background Color setting, 108
Background screen settings, 131
Bands, vertical, 171
Blackboard color mode, 28, 123
Blackboard, projecting on, 27
Blank screen, 21 to 22
Blurry image, 170
bmp, 118
Brightness, 187
Brightness control, 126
Brightness setting, 123

C

Cables
  HD15-to-component, 12, 45
  illustrations, 12
  mouse, 40
  network, 53
  ordering, 13
  remote control cable set, 13
  security, 186
  S-video, 13, 44
  VGA, 38
  VGA-to-component, 12, 45
Camera, see Digital camera
Capturing image, 130
Carrying case, 12
Ceiling mount, 13, 185
Certificate validation, 80 to 81
Cleaning
  air filter, 155
  lens, 154
  projector case, 154
CMYK color format, 118
Color
  correcting, 27
  multi-screen adjustment, 134
  problems, 171 to 172
  saturation, 123
  settings, 122 to 123
  temperature, 123
Color Mode, 27 to 28, 122 to 123
CompactFlash card
  inserting, 51
  moving files to, 151
  projecting from, 100 to 101
  transferring scenarios to, 114 to 115
Component video cable, 13, 41
Composite (RCA) video cable, 41 to 43
Computer
  connecting to, 38 to 41
  selecting source, 20
Connecting projector
  to audio equipment, 48 to 49
  to computer, 38 to 41
  to digital camera, 50
  to external monitor, 47
  to speakers, 49
  to video equipment, 41 to 46
Continuous play setting, 105, 115
Contrast setting, 123
Custom screen, see User’s Logo
Customized color mode, 28, 123

D
Data encryption, 88 to 89
Default settings, restoring, 121
DHCP, 66, 70, 74, 174
Digital camera
  connecting to, 50
  projecting images from, 101 to 102
Direct Power On, 19
Display order setting, 105
Distance from projector to screen, 16, 187
Documentation, 10
DPOF, 118
Drive, external, 100 to 101
DVD player, connecting, 41 to 46

E
EAP authentication, 79 to 80
EAP-TLS certificate, 80 to 81
EasyMP
  problems, 175 to 177
  software, 181 to 183
  starting, 56, 136
Electrical specifications, 188
E-mail alerts, 137 to 138
EMP Monitor
  changing monitoring interval, 147
  monitoring the projector, 139 to 147
  problems, 173
  using, 139 to 147
EMP NS Connection
  configuring projector for, 65 to 81
  creating password for, 58
  disconnecting, 84
  entering keyword, 83
  installing software, 181 to 183
  problems, 173 to 175
  projecting wirelessly, 55 to 92
  using, 81 to 92
EMP SlideMaker
  checking scenarios, 113
  converting PowerPoint files, 105 to 106
  creating scenarios, 105 to 112
  problems, 175 to 176
  setting up transitions, 111 to 112
  transferring scenarios to drive, 114 to 115
Encryption, 63, 69, 76 to 77, 88 to 89
Environmental specifications, 189
Epson
  accessories, 13
  presentation tips, 11
  PrivateLine Support, 10
  technical support, 10, 178 to 179
  warranty, 11
ESSID, 60, 63, 69, 74, 84, 174
Ethernet connection, 136 to 137
Explorer, Windows, 151
External drive, projecting from, 100 to 101
External monitor, connecting, 47
E-Zoom button, 32

F
FCC compliance statement, 195
Files, sending to projector, 151
Filter, see Air filter
Finder, Macintosh, 151
Focusing image, 24
Freeze button, 32
FTP, sending files to projector, 151

G
Game color mode, 28, 122
Gateway address, checking, 72
HDTV images, video formats, 191
Height of image, adjusting, 23
Help, 178 to 179
Help system, using, 164
Help, Epson, 10
High altitude, 133, 166

Image
adjusting, 23 to 28, 122 to 123
blurry, 170
capturing and saving in projector, 130
correcting shape, 24 to 27, 126, 169
fitting on screen, 125, 169
height, adjusting, 23
problems with, 167 to 172
projecting on chalkboard, 27
raising, 23
rotating, 101, 102, 103, 117
selecting source, 20, 30, 43 to 46
shape, correcting, 24 to 27
size and projection distance, 16, 187
turning off (using A/V Mute), 31
turning off temporarily, 31
zooming, 24, 32
Image menu, 122 to 123
Info menu, 159 to 160
Infrastructure mode, see Access Point mode
Input signal, selecting, 20, 30, 43 to 46
Installing projector, 185 to 186
Installing software, 181 to 183
Instant Off, 20
IP Connect Mode, 86 to 87

jpg, 118

Kensington anti-theft device, 13, 17, 186
Keystone correction, 24 to 27, 126, 169, 187
Keyword, 58, 83

Lamp
number of hours used, 159 to 160
ordering, 13
replacing, 156 to 159
specifications, 188
status light, 165 to 166
Lamp timer, resetting, 159
Language setting, 133
Laptop computer
connecting to, 38 to 39
display problems, 21 to 22, 167 to 168
selecting source, 20, 30
LEAP authentication, 79 to 80
Lens, cleaning, 154
Lights, status, 165 to 166
Locking projector, 83
Logo, saving on projector, 129 to 131

Mac
configuring for wireless, 63 to 64, 73 to 75
display problems, 168
EasyMP system requirements, 182
Finder, 151
Manuals, 10
Menus
changing settings, 120 to 121
default settings, restoring, 121
Image, 122 to 123
Info, 159 to 160
network, 57, 59, 65, 75, 77, 79, 80, 136, 137
Signal, 124 to 125
User’s Logo, 130
Monitor, connecting, 47
Monitoring projector
e-mail notifications, 137 to 138
EMP Monitor, 139 to 147
Mouse
compatibility, 187
connecting cable for remote, 40 to 41
using remote control as, 34
Movie files
  projecting from external drive, 100 to 101
  using in scenarios, 108 to 111
Movie Sending Mode, 92 to 93
MPEG, 92, 118
mpg, 118
mrk, 118
Multiple projectors, controlling, 35 to 36
Multi-screen color adjustment, 134
Multi-screen projection, 90 to 92, 183

N
Network
cable, 53
  managing projector remotely, 135 to 150
  problems, 173 to 175
  projecting, 81 to 84
  security, 87 to 89
  setting, 142, 151
  wired, 136 to 137
  wireless, 52, 55 to 97
Network card
  compatible, 181
  inserting, 52
Network settings, configuring, 56 to 81
No Signal message, 21, 168
Noise level, 187
Not Supported message, 169
NS Connection, see EMP NS Connection
Numeric keypad, using, 128

O
Operation Lock setting, 126, 131
Optical aspect ratio, 187
Options for projector, 13

P
Password
  protection, 127 to 129
  remote access, 58
  request code, 129
PC Free, 100 to 105, 116 to 118
PEAP authentication, 79 to 80
Photo color mode, 28, 122
Picture source, selecting, 20, 30, 43 to 46
Picture, see Image
png, 118
Pointer shape, 126
Pointer tool, using, 33 to 34
Positioning
  image, 23
  projector, 16 to 17, 185 to 186
Power
  button, 19
  specifications, 188
  status light, 19, 165 to 166
PowerPoint files
  adding slides to a scenario, 108 to 110
  converting to scenarios, 105 to 106
  presenting, 116 to 117
  problems, 175 to 176
Presentation color mode, 28, 122
Presentation Mode, 94
Presentations
  computer, 38 to 41
  digital camera, 50, 101 to 102
  images and movies, 100 to 105
  room conditions, 16, 30
  scenarios, 116 to 117
  tips and training, 11
  using the pointer tool, 33 to 34
  video, 41 to 46
  wireless, 55 to 92
Presenter View, 94 to 97
Presenters Online, 11
PrivateLine Support, 10
Problems
  color, 171 to 172
  connecting wirelessly, 84 to 85, 173 to 175
  image, 167 to 172
  monitoring projector, 173
  no signal, 21, 168
  remote control, 177
  scenarios, 175 to 176
  sound, 172
  using on-screen help, 164
Progressive format, 118, 125
Projecting without screen, 27
Projection lamp, see Lamp

Projector
  cleaning, 154
  disabling buttons, 131
  distance from screen, 16, 187
  installing, 185 to 186
  lamp specifications, 188
  locking, 83
  monitoring remotely, 135 to 150
  options, 13
  password protection, 127 to 129
  positioning, 16 to 17
  resolution, 187
  security features, 127 to 131, 186
  specifications, 187 to 189
  transporting, 161
  troubleshooting, 163 to 166
  turning off, 20
  turning on, 17 to 19
  unpacking, 12
  viewing information about, 159 to 160

Projector ID, setting, 35 to 36

Q
  Quick Corner, 25, 126

R
  Raising image, 23
  Rear-screen projection, 132, 185
  Registration, 11

Remote control
  A/V Mute button, 31
  as wireless mouse, 34
  battery used, 188
  connecting cable for mouse, 40 to 41
  controlling multiple projectors, 35 to 36
  correcting color, 27
  E-Zoom button, 32
  Freeze button, 32
  ID, 36
  numeric keypad, using, 128
  pointer tool, using, 33 to 34
  problems, 177
  range, 188
  running slideshow with, 116 to 117
  specifications, 188
  switching sources, 30
  troubleshooting, 177
  Remote Receiver setting, 127
  Replacing lamp, 156 to 159
  Request code, password, 129
  Resetting lamp timer, 159
  Resetting menu options, 121
  Resize image, 28
  Resolution, 28, 169, 187
  Rotating the image, 101, 102, 103, 117

S
  Safety
    instructions, 193 to 195
    specifications, 189
  Saturation setting, 123
Scenarios
adding movie files, 108 to 111
adding sound, 108
background color, 108
cells, 110
converting PowerPoint files, 105 to 106
creating, 105 to 112
default location, 108
exiting, 103, 117
presenting on the projector, 116 to 117
previewing, 113
problems, 175 to 176
rearranging, 110
running automatically, 114 to 115
transferring to drive, 114 to 115
transitions, 111 to 112
Screen
blank, 21 to 22
distance from projector, 16, 187
ordering, 13
startup screen, creating, 129 to 130
Screen image, see Image
Screen switching time setting, 105
Security
cables, 186
identifying logo, 130 to 131
Kensington lock, 13, 186
network, 87 to 89
Operation Lock, 131
password protection, 127 to 129
Sharpness setting, 123
Signal menu, 124 to 125
sit (presentation file type), 118
Six-axis color adjustment, 123 to 124
Sleep mode, 18
SlideMaker, see EMP SlideMaker
Slideshow, creating from images, 102 to 105
Software installation, 181 to 183
Sound
adding to scenarios, 108
troubleshooting, 172
Source, selecting, 20, 30
Speaker, specifications, 187
Speakers, connecting, 49
Special effects, adding to slide transitions, 105, 112
Specifications
brightness, 187
dimensions, 188
electrical, 188
environmental, 189
general, 187
lamp, 188
remote control, 188
resolution, 187
safety, 189
Sports color mode, 28, 122
sRGB color mode, 28, 123
Standby Mode setting, 142, 151
Startup screen
creating, 129 to 131
settings, 131
user’s logo, see User’s Logo
Status lights, 165 to 166
Support, see Technical support
S-video cable, 13, 44
Switching picture source, 20, 30
Sync setting, 125
Synchronization, adjusting, 171
Technical support, 10, 178 to 179
Temperature
requirements, 189
status light, 165 to 166
Temperature, color, 123
Test pattern, displaying, 127
Text color mode, 28, 122
Theatre color mode, 28, 122
Thumbnails, scenario, 109
Tint setting, 123
Transferring files to projector, 151
Transitions, scenario, 111 to 112
Transporting projector, 161
Troubleshooting
  blank screen, 21 to 22, 167 to 168
  cut-off image, 169
  distorted image, 24 to 27
  EasyMP problems, 175 to 177
  image and sound problems, 167 to 172
  network problems, 173 to 175
  no signal, 21, 168
  projector problems, 163 to 166
  remote control problems, 177
  tapered image, 24 to 27
  wireless projection problems, 84 to 85, 173 to 175

Turning off picture (using A/V Mute), 31
Turning off projector, 20

U
Unpacking projector, 12
USB
  cable, 12, 39, 41
  display, 39 to 40
USB drive
  projecting from, 100 to 101
  transferring scenarios to, 114 to 115
User’s Logo
  creating, 130
  display settings, 131

V
VCR, connecting, 41 to 46
Video
  cables, 12, 13, 41
  connecting video equipment, 41 to 46
  formats, supported, 189 to 191
  projecting wirelessly, 92 to 95
  selecting source, 20, 30, 43, 44
Video Signal setting, 125
Virtual display, 183
Volume, controlling, 33, 126

W
Warning lights, 165 to 166
Warranty, 11
WEP encryption, 76 to 77
Windows
  configuring for wireless, 61 to 63, 67 to 71
  display problems, 168
  EasyMP system requirements, 181
  Explorer, 151
Wired network, 136 to 137
Wireless
  connecting manually, 86 to 87
  EAP, 79 to 80
  EAP-TLS, 80 to 81
  LEAP, 79 to 80
  module, 12
  network card, 52, 56, 181
  PEAP, 79 to 80
  presentation, 55 to 92
  problems, 173 to 175
  security, 87 to 89
  WEP encryption, 76 to 77
  WPA security, 77 to 78
Wireless, mouse, 34, 40 to 41
WPA security, 77 to 78

Z
Zoom ratio, 187
Zooming image, 24, 32